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WELCOME
ISSUE 132

Welcome to the latest 
issue of Advanced 
Photoshop. You asked us 
for advice on retouching, 
so we’ve got a fantastic 
tutorial from expert John 
Ross to help you make 
the most of your photos!

INTHIS ISSUE:

PHOTOMANIPULATION
DIGITAL PAINTING

MATTE PAINTING
RETOUCHING

APRIL MADDEN
Editor

Retouching can be a controversial subject. On 

one hand there’s the debate about how overly 

retouched images can affect body image, especially 

when they’re shown in the context of fashion 

magazines or cosmetics adverts. On the other, there 

aren’t very many people who haven’t thought about 

cloning out the odd spot or wrinkle from their own 

photo. So where do you draw the line? Our tutorial 

from John Ross contains key advice on what you 

should keep and what you should remove in a 

beauty retouch, and how this differs from retouching 

a documentary portrait. It’s fascinating stuff.

Where do you stand on the retouching debate? 

Are you a dab hand with Liquify or do you prefer 

portraits to be warts and all? Do you delight or 

despair over the ever-increasing collection of 

celebrity Photoshop fails that the internet 

obsessively documents? Head over to our Facebook

or Twitter and let us know w

Enjoy the issue! 

FINDUSONLI

@advancedpshop /AdvancedPhotoshop

.co.uk
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EYE ON DESIGN    PRO PANEL

PRO PANEL
MEET THE PROFESSIONALS SHARING THEIR PHOTOSHOP 
EXPERTISE AND TECHNIQUES IN THIS ISSUE

JOHN ROSS 
www.theartofretouching.com 
Try not to get hung up on the details. Always ensure that you work on the overview first, and continue throughout the process. Zooming 

in and back out again to evaluate and re-evaluate is critical to keeping the image looking its best. Worry more about the feeling and the 

emotion, and less about having every hair in the correct place. 

■ Get more professional retouching advice from John Ross in his tutorial on p44

NADEGDA MIHAILOVA 
www.nm-art.weebly.com

You can create a beautiful landscape from ordinary photos.

Even a fantasy scene can be built up out of ordinary real-world

images like skies, trees, geographical features and buildings.

The trick is to carefully choose the elements you’ll use and use

Transform and Warp tools to turn them into something else.

■ Learn more about creating a fantasy matte painting from photos in

Nadegda Mihailova’s tutorial on p38

© John Ross

© Rolf Anders Jensen© Nadegda Mihailova

ROLF ANDERS JENSEN 
www.rolfjensen.no

Even if you think you’ve planned for everything and it seems 

to be a perfectly thought out user experience, it can get lost 

when attention to certain details falls short. Little things add 

up to the ideal user experience: straightforward yet personal 

microcopy, working with the strengths and weaknesses of infinite scrolling, and 

well-crafted feedback loops can all influence a user’s behaviour.   

■ Find out more about designing great websites with Photoshop in Rolf 

Anders Jensen’s tutorial on p60

Worry more about the feeling and 
the emotion, and less about having 

every hair in the correct place
JOHN ROSS /  WWWTHEARTOFRETOUCHING.COM 
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ANDY HAU 
www.andyhau.com

It is amazing how much depth can be achieved by using a simple Gradient Fill. However, 

when you transition colours together, colour banding often occurs. This is where you see 

stripes of colour rather than a smooth gradient. To overcome this, simply tick the Dither 

option in the Gradient Fill options or add Noise to subtly break up the gradient.

■ Discover how Andy Hau created fresh type techniques in his tutorial on p50

© Andy Hau
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FOTOLIA COMES TO 
CREATIVE CLOUD 

THE LEADING DESTINATION FOR STOCK IMAGERY 
IS NOW AVAILABLE IN YOUR CC LIBRARY  Adobe has officially revealed that it has 

entered into a definitive agreement to 

acquire privately-held Fotolia, a stock 

imagery leader, for $800 million in cash.  

With websites in 14 languages and 23 regions, it 

was the first worldwide micro stock organisation to 

offer both crowdsourced and professional images in 

one place. Its introduction of the Infinite collection, 

then gave buyers access to over 34 million images, 

vectors, and videos. The stock photo giant is also 

well-known for presenting the TEN Collection – 

where anyone can download five exclusive PSDs 

created in collaborations between one photographer 

and one designer apiece. 

For Adobe, the acquisition certainly makes sense, 

allowing Fotolia’s vast collection of images to be 

integrated into Creative Cloud. The shift will mean 

stock photos will be more easily available to the 3.4 

million members of CC, which could affect other 

image banks who can’t compete in price or 

convenience. Adobe now has an amazing opportunity

to become more powerful than ever in this space by 

connecting its Behance and Fotolia services together.

“The acquisition of Fotolia will reinforce Creative 

Cloud’s role as the preeminent destination for 

creatives,” said David Wadhwani, senior vice president

of Digital Media, Adobe. “Creative Cloud is becoming 

the go-to marketplace for the creative community to 

access images, videos, fonts and creative talent, 

through critical creative services like Fotolia and our 

new Creative Talent Search capabilities.”

Oleg Tscheltzoff, the founder and CEO of Fotolia 

has said, “Becoming part of the Adobe family is a 

dream come true for the Fotolia team and will

     EARNING MORE THROUGH CC 

Adobe has already taken steps into the stock 

photography business by launching the Creative 

Cloud Market – allowing artists to not only look 

for jobs but also sell content to buyers. Last 

October, the company also launched the Creative 

Talent Search on Behance; allowing anyone with 

an Adobe Account logging into Behance to 

explore 4 million creative professionals, get 

recommendations on which artists to hire, and 

discover artists through Talent Search.  

With the acquisition of Fotolia, Adobe can 

soon provide users a way to enhance their 

Creative Cloud experience through a new 

platform – one which provides stock photos, 

images, graphics and HD videos, as well as 

supporting Fotolia as a standalone offering. As 

Fotolia becomes more integrated, Adobe has 

said it believes members will start to use the 

Creative Cloud to discover and buy content, as 

well as to sell and showcase their work.

accelerate our vision to become the best place for

artists to build a business and the ultimate destination 

for designers to find stunning creative work.” 

Earlier in 2014 Adobe had already shown interest 

in providing similar media to its customers with the 

launch of the Creative Cloud Market, a collection of 

high-quality assets such as vector graphics, icons, 

patterns, UI kits, and more – provided in collaboration 

with creatives on Behance, all of which could be 

easily accessed from the Creative Cloud Desktop app 

as part of a subscription to the Creative Cloud. In the 

official press release announcing the acquisition, 

however, Adobe has stated that it plans to continue to 

operate Fotolia as a standalone stock service 

accessible to anyone; whether they’re on the Creative 

Cloud or not. The transaction is expected to be 

finalised very soon, until which time each company 

will continue to operate independently. Fotolia CEO, 

Oleg Tscheltzoff, will continue to lead the Fotolia team 

as part of Adobe’s Digital Media business.

See more information on Adobe’s acquisition of 

Fotolia at www.adobe.ly/1zyo3Iy.

Creative Cloud is becoming 
the go-to marketplace for 

the creative community to 
access images, videos, fonts 
and creative talent

Great investment: Adobe Headquarters 
in San Jose. The company has planned to 
acquire stock photography giant Fotolia 
for $800 million in cash 

The future for Creative Cloud : Acquiring Fotolia will 
allow for Creative Cloud users to have easier access to 
competitively priced stock images



009

WACOM ANNOUNCES NEW 
FLAGSHIP CINTIQ

HP LAUNCHES HOLOGRAPHIC ZVR DISPLAY

CES SAW THE THE INTRODUCTION OF SOME HIGHLY 
ANTICIPATED NEW TABLETS FROM WACOM 

THE NEW MONITOR WILL ALLOW ARTISTS TO MANIPULATE
3D MODELS AS HOLOGRAPHIC PROJECTIONS

Wacom has certainly made a lot of Photoshop 

users very happy with its unveiling of three brand 

new types of Cintiq tablets at CES this year – 

including the flagship Cintiq 27QHD and 27QHD 

Touch.  Both feature a 27-inch widescreen 

seamless edge-to-edge glass working surface 

with four times the pixel density of standard HDTV 

at 2560 x 1,440; as well as a colour quality which 

displays 97 per cent of Adobe’s colour gamut, 1.07 

billion colours and REC 709. 

Accessories have also been updated for the 

Cintiq 27QHD and 27QHD Touch. As well as 

Along with several 4K and 5K ultra-high definition 

displays as well as curved displays for consumers 

and professionals, HP has wowed both virtual 

reality and Star Wars fans alike by revealing its 

work on a new 23.6-inch diagonal interactive 

virtual display, the HP Zvr.

Powered by zSpace technology, the Zvr allows 

anyone wearing a lightweight set of 3D glasses to 

view and manipulate virtual-holographic 3D 

projections that appear to be floating straight out 

of the monitor, with a pen-like input device. Head 

tracking via four separate cameras then allows 

images to be projected at an appropriate angle. 

The company has said that users will 

appreciate real-time, natural interaction that 

allows anyone to work with virtual reality 

applications the way they are used to working 

today; combining a high-definition, 3D 

stereoscopic display with full-motion parallax 

and direct interaction to deliver an intuitive user 

experience with lifelike realism. This is not the 

first time HP has surprised with its portfolio 

recently, with the company having also 

introduced its own very unique take on a 

‘creativity station’ capable of full 3D scanning 

with the Sprout PC last year.

Wacom’s Pro Pen with 2048 levels of 

pressure sensitivity, artists using the tablets 

will also have instant access to customised 

shortcuts and on-screen control with the new 

ExpressKey Remote, which can be placed 

anywhere on the screen. Prices start from £1800 

for the Cintiq 27QHD, and £2100 for the 27QHD 

Touch with touch-enabled software that allows 

you to rotate, move, and pinch your work with 

your hands as well as the Pro Pen and remote. 

For a less costly £1200, the second 

generation Cintiq Companion 2 seems to 

“HP’s new displays 

complement our goal of 

delivering new technologies that 

maximise the visual experience and 

change the way people work and create,” 

said Jun Kim, vice president and general 

manager of PC displays and accessories, 

HP. “HP displays feature performance, 

innovation, reliability and outstanding image 

accuracy that we believe will transform how 

customers connect and interact using technology.”

combine the best of the previous Cintiq 

Companion and Cintiq Companion Hybrid for 

digital artists. A fully mobile Windows 8 tablet, 

the Cintiq Companion 2 has all the capabilities 

of a Cintiq Companion – but if needed it can also 

be connected to a Mac or PC to be used as a 

more traditional tablet display.

The Cintiq Companion 2: 
Unlike the first Cintiq Companion, 

the Cintiq Companion 2 can be connected 
to a Mac or PC to be used as a traditional 

tablet display if needed

Using the Cintiq 27QHD: Learn more about the new Cintiq 27QHD 
anad Cintiq 27QHD Touch, as well as new accessories such as the 
ExpressKey Remote and Cintiq Ergo stand, at www.bit.ly/1ARlWlk

Holographic interaction: The HP Zvr 
display allows for a user wearing a 
pair of 3D glasses to see and interact 
with immersive virtual-holographic 
3D images using a pen input device 
– bringing us one step closer to true 
holographic viewing

Connectivity and Content: Dual-link DVI or DisplayPort connections 
to the HP Z Workstation provide easy connectivity for architectural, 

MCAD, education, and scientific content
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THE INCREDIBLE ITALIAN ARTIST ALBERTO SEVESO TALKS 
PHOTOSHOP AND EXPERIMENTING WITH AN INKJET PRINTER

IL PHOTOSHOP 
BELLISIMO

Alberto Seveso
www.burdu976.com

A
lberto Seveso’s work perhaps sums up a

Photoshop generation. Merging stunning

photography with intriguing shapes and

objects, his images are always captivating

and impactful – typically and effortlessly Photoshop.

His work emanates beauty, no matter what the

subject, showing the artist’s Photoshop prowess by

adding swirling flowers, dynamic shapes and vibrant

colours to portraits and photography. It’s unsurprising

that Seveso’s trademark style has seen him gain

commissions from some of the biggest clients around,

including Adobe,Playboy, ESPNThemagazine, Sony

and O2. And his work has graced the album covers of

numerous bands including The Temper Trap and

In my profession I think
that the most challenging

part is to simply get the
commission! When you receive
a commission it means that
people believe in you
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Frankmusik. Seveso recently moved to Bristol, UK for 

creative inspiration after growing up in a small village 

in Italy. Since he started experimenting with Photoshop 

in the Nineties, he hasn’t looked back.

TELL US ABOUT YOUR BACKGROUND AS AN 

ARTIST. WHERE DID YOU STUDY AND HOW DID 

YOU GET INTO DIGITAL ART?

My passion for graphics and digital art started in the 

mid-Nineties. I was [always] hugely fascinated by the 

graphics on skate-decks and the album covers of 

metal bands. As this passion grew, I started to think 

about how to reproduce this kind of art. Since the 

Commodore VIC-20, we always had a computer in 

our home and as I grew up, I kept thinking that my 

computer could be great for digital art, that I could 

use the computer to make art and not just to play 

games! The real turning point was when a friend of 

mine showed me Photoshop, [I] think it was in 1997 

and it was love at first sight. I’ve never studied graphic 

design or art – I’m completely self-taught.

WHEN DID YOU MOVE TO THE UK FROM  

YOUR NATIVE ITALY AND WHAT BROUGHT  

YOU HERE?

I moved to Bristol in 2014 for many reasons. The 

main reason though is because I needed to learn 

English. I’m studying English at college. It’s so exciting 

to go back to school with homework, classmates and 

so on. I have to [learn English] because my clients are 

from all over the world and I need to communicate 

with them more effectively. Secondly, I come from a 

small village, I love my town but it is so boring! I 

needed to live in a creative place like Bristol to inspire 

me. The final reason was because I wanted to drink a 

coffee with Banksy on the harbourside. 

HOW WOULD YOU SUM UP YOUR UNIQUE � 

AND BRILLIANT � STYLE? AND HOW HAS IT 

DEVELOPED OR CHANGED OVER THE YEARS?

My style is simple, yet complicated and confused at 

the same time – like something raw that is waiting 

to evolve. Naturally, I found my own style but that 

certainly doesn’t mean that it’s always the same. 

Every single day I’m looking to improve my style, 

to add something new without losing the overall 

look and feel. I guess I would describe my style as 

a work in progress. 

WHAT WAS THE BRIEF FOR THE ADOBE 

CAMPAIGN AND WHAT WAS IT LIKE WORKING 

ON SUCH A HUGE PROJECT?

The brief was really simple with Adobe wanting me 

to ‘be myself’, they chose me for my style and how it 

Adobe Photoshop CS6 Extended: Created in collaboration 
with Tolleson Design (www.tolleson.com), Seveso was 
responsible for the striking artwork for Adobe’s CS6 campaign
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Superbum: Shot by photographer Ramón 
Gellida and manipulated by Seveso, this 

image was part of men’s underwear label 
Superbum’s 2011 campaign

Sony MDR, The art of sound: When Sony 
needed an artist to produce a series of images 

for its new high-definition headphones, who 
else but Seveso would do? This portrait was 

commissioned by Frontage Asia
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Colora i tuoi Sogni: One of 
Seveso’s trademark Photoshop 

portraits, this image was created for 
the launch of the Centre of Research 

& Innovation in Rennes, France
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would work with CS6. The Adobe team was great 

[and] I met some wonderful people during the 

project. It was very much the perfect job.

WHAT HAVE BEEN YOUR FAVOURITE RECENT 

PROJECTS TO WORK ON?

I’m extremely proud of my latest experimental series 

that I call Digital Vomit. It’s a new way for me to 

create. In Bristol, I’m surrounded by painters and I 

love the medium. When I see a beautiful project on 

the web done by a great painter I just want to paint. 

But unfortunately, I’m not a painter. I’m not that good 

at drawing with pencil or using brushes and I’ve 

always admired people who can draw and paint ‘in 

the real world’ [rather than digitally]. This is the main 

idea and inspiration behind this project: to do 

something very similar to a painting, something 

analogue, something handmade and something 

unique and not easy to replicate. I achieved this by 

using a common tool of my generation, an inkjet 

printer. I manipulate the output using brushes and a 

few other tricks. You can see a behind-the-scenes 

video at www.vimeo.com/103250663.

WHO WOULD YOU REALLY LIKE TO WORK FOR 

OR WITH � WHO ARE YOUR DREAM CLIENTS 

AND COLLABORATORS?

Well, if I had a genie and could make a wish I would 

like to work for Santa Cruz Skateboards – I’d love to 

design some boards for the company. The perfect 

clients though are companies like Adobe, and the 

CS6 job I did, but these jobs are very rare. It’s great 

when someone chooses you just for your style, 

someone who believes in you and loves your work. I 

don’t particularly like the clients who ask me to do 

something that isn’t in my style.

WHAT IS USUALLY THE MOST CHALLENGING 

PART OF A COMMISSION?

Some time ago I read an interview with Reinhold 

Messner [the Italian mountaineer, adventurer, 

explorer, and author]. He said that the most 

challenging part when he was climbing Everest 

was to get out of the tent. Well, in my profession I 

think that the most challenging part is to simply 

get the commission! When you receive a 

commission it means that people believe in you 

and when people believe in you, it means that the 

hardest part of the job has been done. You are out 

of the tent.

WHAT HAS PHOTOSHOP DONE FOR YOU AS AN 

ARTIST? AND WHAT WOULD YOU BE DOING IF

013

EYE ON DESIGN  PORTFOLIO INTERVIEW    

It’s great when someone 
chooses you just for your 

style, someone who believes in 
you and loves your work

The Temper Trap: Seveso 
created the artwork for The 

Temper Trap’s 2012 eponymous 
album. The artwork was 

produced in collaboration with 
Boat Studio and Infectious Music

Bay Area News cover: Seveso 
created this stunning and dynamic 

football-themed image for Bay Area 
News, San Francisco 
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IT NEVER EXISTED?

Everything. Without it I would not be a creative 

professional. I experimented in the past with street 

art and graffiti but I suck.

WHAT ARE YOUR FAVOURITE TOOLS AND HOW 

DO YOU USE THEM TO CREATE YOUR 

STUNNING WORK?

The most important features for me are, simply, 

layers. Without them I can’t do anything. I use an 

enormous amount of layers, with all of my works

being composed of hundreds of them. Each shape in

my work is a single layer, so it’s simple, without

layers I can’t express my style.

WHAT DO YOU THINK SEPARATES YOUR WORK

FROM OTHER ARTISTS’?

Well, first of all I don’t think that I’m [a] good

illustrator, creative or whatever [we disagree – Ed].

There are lots of highly talented illustrators and

artists out there. But, for sure, people love my

artwork because of the way that I illustrate figures

and portraits in my own original style and for the

way in which I use colour.

HOW IMPORTANT IS GOOD PHOTOGRAPHY    

TO YOUR WORK? 

Hugely important. I always begin with a good shot. 

Researching the photography and getting the right

model is the most important, and sometimes the

hardest, part. Sometimes I’ll take my own photos,

sometimes I’ll buy them, and sometimes the client

will give me a shot to work with.

WHAT ADVICE WOULD YOU GIVE TO

YOURSELF IF YOU COULD TRAVEL BACK IN

TIME TO THE START OR YOUR CAREER?

I don’t know – I’m pretty happy with my

achievements. Maybe I’d like to think to the future.

I’ve been a freelancer for a long time but would like

to work with an agency and surround myself with

great and talented people.
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My style is simple, yet complicated and confused at the 
same time – like something raw that is waiting to evolve. 

Naturally, I found my own style but that certainly doesn’t 
mean that it’s always the same

WHAT WOULD BE YOUR THREE KEY TIPS OR 

PIECES OF ADVICE FOR ARTISTS TRYING TO 

START A CAREER?

Be yourself. Don’t copy anyone. Don’t follow trends.

■ BE ORIGINAL 
In my opinion, being original is the most important part of a 
portfolio. People are always searching for something new, 
so you must show originality in what you do.

■ SHOW YOUR COMMERCIAL WORK 
Be careful with your artistic side – don’t fill up your portfolio 
with personal work. I think it’s important to try and find the 
balance between good commercial work and your personal 
stuff. Show your creativity, but at the same time your 
practical side – we are workers before being artists. Artists 
are another thing altogether.

■ DON’T REVEAL YOUR SECRETS 
Always put in finished works and if you like surround them 
with sketches/images of the work in progress, 
step-by-steps and some behind-the-scenes material, but 
never reveal your secrets. A series is always better than a 
single image. Always put a description of your work, as well.

PORTFOLIO TIPS
SEVESO OFFERS HIS TIPS FOR A PERFECT 
PHOTOSHOP PORTFOLIO

Ayaka poster: Sayaka is a Japanese 
performing artist and Seveso 

designed the album artwork for her 
2013 single Beautiful 

Digital vomit: ‘Digital Vomit’ is a series of personal 
works by Seveso where he manipulates inkjet printouts 
using traditional tools including paints and inks



FDM1-2KKZJ
www.instantprint.co.uk

Roses are blue,
Violets are red,
we’re rubbish at poems,
we print fast instead.

- Instantprint.co.uk
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G rowing up outside of Boston, Massachusetts,

Morgan Schweitzer’s first figurative 

drawings of his family revealed what a 

unique artist he would grow up to be. He 

began drawing human figures revised to exclude the 

torso, with limbs that extended directly from the 

bottom of the head. “I’d like to think my artistic voice 

has evolved since then,” Schweitzer adds.

Today, he works professionally for clients including

Businessweek, Buzzfeed, Penguin, The Mill, and

Psyop, producing art almost exclusively in Photoshop.

As with his childhood illustrations, however,

Schweitzer frequently finds a way to think outside the

box – delving into controversial themes and building

his own brushes from scanned traditional media

textures such as charcoal, graphite, and ink.

Creating When Art is Watching You for a client like

The Wall Street Journal was no different, even with a

quick turnaround during a busy time. Here

Schweitzer discusses how he conceptualised and

created this high-profile commission.

TELL US MORE ABOUT YOURSELF, AND

HOW YOU STARTED ILLUSTRATING?

I’ve always been a drawing-guy. Drawing and

sculpture were activities that always held my

attention as a kid. I studied illustration in college, and

through a good deal of self-promotion, started client

work as a freelancer shortly thereafter.

HOW DO YOU CREATE SUCH THOUGHT

PROVOKING PIECES OF ART?

The thought-provoking part has more to do with the

way I conceptualise ideas. For me, it’s helpful to have

a jumping-off point. It’s much harder to think outside 

the box if there is no box at all. In this case, the box 

was the topic of the article that I was illustrating – 

museums mining data from visitors. I like to separate 

the concept into categories.

For this illustration it was museums and data 

mining. Then I start writing words that I associate 

with each category, the hope being that I will be able 

to combine words from each category into a visual 

concept. For this illustration the words were 

sculpture, within the museums category, and 

surveillance, within the data mining category.

WHAT MAKES PHOTOSHOP SO IMPORTANT TO 

YOUR WORKFLOW?

Photoshop is the tool I use from start to finish in most of 

my illustrations. While I use many of my own scanned 

ink and paint textures in my illustrations to give them 

more life and tactile expression, generally the whole 

piece is created inside Photoshop. I have built some of 

my own brushes for sketching, line work and shading 

and I use other tools for colour and lighting.

ABOUT THE ARTIST

A�er experimenting with art from a
young age, Schweitzer received his
BFA from Washington University in

St Louis and shortly a�er
graduating moved to New York,

where he started his career in
illustration working for editorial

clients as well as animation studios
as a development artist. He now

resides in Los Angeles, California.

MORGAN SCHWEITZER
www.morganschweitzer.com

WHEN ART IS
WATCHING YOU

NAME OF PROJECT

WE TALK TO MORGAN SCHWEITZER ABOUT HOW TO MAKE 
EVERY ILLUSTRATION MEAN SOMETHING UNIQUE

THINK DIFFERENT
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er‘Diner Monster’, front and back cover for The Normal School 

An illustration from a set for an 
article for the Los Angeles Times
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shadows and then it becomes a long game of push

and pull, adding colour and tone, and adjusting

values. Lastly, I work on the piece as a whole, tying

all the parts together with washes, adjustment layers

and some texture, being mindful of how the

composition is evolving as I go.

WHAT WERE THE MAIN PHOTOSHOP TOOLS

AND TECHNIQUES YOU USED FOR THE

CREATION OF THE PIECE?

For the line drawing I used a custom brush [that] I

created in Photoshop. I tend to use a lot of clipping

mask layers. Once I block out each shape, all the

colours, shading and value layers are clipping masks

linked to the original shape layer.

I put each spatial area into a folder in my layers

palette so I can adjust foreground, background and

mid-ground separately, allowing me to push spatial

areas back or pull them forward with lighting.

WOULD YOU RECOMMEND A YOUNG ARTIST,

HOPING TO BE AN ILLUSTRATOR, LEARNS

PHOTOSHOP? IF SO, HOW WOULD YOU

SUGGEST THEY GO ABOUT IT?

Absolutely. Whether you use traditional or digital

media, Photoshop is an incredible tool to finalise an

illustration, or to create a piece in its entirety. I learned

HOW DID YOU CREATE AND ILLUSTRATE WHEN
ART IS WATCHING YOU?

After the brainstorming and conceptualising phase I

sketch a series of thumbnails for each concept,

exploring different compositions for each idea. Then,

I produce sketches of three to five different ideas.

The concept is then chosen by the art director. The

next step is to refine the sketch into a finished line

drawing that is separated into spatial layers. During

this part of the process, I gather visual references to

help guide me through the drawing. With this piece,

I drew from many images of classical sculptures and

museum interiors.

Next, I block out the values of all the shapes. I add

Perspective and areas of contrast 
or colour variation draw the eye 
to the focus of the piece

Lightening the line work in the 
background creates depth and stops 
background elements from competing 
with other areas of higher importance

‘Into The Night’ Illustration for Cycle World Magazine

the basics of Photoshop in art school, but I’m still 

learning new techniques all the time. It’s fascinating 

how differently each artist uses it.

I still check advice boards and tutorials when 

there’s something new I want to figure out. The best 

way to learn is through an assignment. If you have a 

goal, the learning becomes a secondary asset to the 

process, but you’re implementing each skill as you go 

and committing it to memory through experience.

WHAT WOULD YOU MOST LOVE TO SEE AS 

DEVELOPMENTS WITHIN THE NEXT VERSIONS 

OF PHOTOSHOP?

I would love to see more nuanced tools that replicate 

traditional art materials. All too often digital work can 

feel very sterile and machine-made. A goal with my 

work is to have it feel more tactile, but I only achieve 

that through the use of my own brushes and textures 

that I implement in Photoshop.

WHERE DO YOU HOPE TO BE IN FIVE 

YEAR’S TIME?

I’d like to continue to develop my artistic voice, and 

personal aesthetic. That’s something that has 

become very important to me, and I feel that I have 

only begun to explore it. I’m curious where it will   

take me. I hope it’s someplace great. 

Line drawing

Blocking values 

Final composition

Adding traditional media 
texture unifies the piece as a 
whole and makes it feel more 
tactile and handmade



WE SPEAK TO JOÃO OLIVEIRA, FOUNDER AND CREATIVE DIRECTOR 
OF THIS SMALL, INDEPENDENT STUDIO AND THE MAN BEHIND
THE POPULAR ONREPEAT TYPES FOUNDRY
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Onrepeat Studio is something of a one-man 

band, but with an impressively large output. 

It’s run by João Oliveira, who set up 

Onrepeat in 2008 when he was in college 

studying Communication Design.

Originally it was an online showcase of his 

personal and professional projects before developing 

into more. Oliveira says, “I was experimenting with 

various styles and it evolved a lot as the years 

passed, becoming more like a business and less like 

an online playground, as I got my first big clients and 

started realising I could work as a creative or an art 

director and lead my own projects. It’s still a 

developing project though, always evolving and far 

from what I idealise it to be – I have big plans for it.”

Those big plans include expanding the studio at 

some point and also the work that Onrepeat takes 

on, “I can’t predict what will happen in the near 

future, but I definitely have the objective of expanding 

my studio and leading my own team to work on even 

bigger projects. The fact that I’ve been working more 

on motion projects also made me rethink what I 

want for the future of my studio, so I can see motion 

graphics and interactivity becoming key areas in its 

future, and for that I will definitely need to assemble 

a team. When will that happen? I don’t know, but I’m 

absolutely certain that I will make that move and 

expand my studio in the future in order to create 

even bigger projects the way I want them to be.”

For now, though, Oliveira works in his small 

studio space alone, “It’s a space customised to my 

creative needs and filled with everything that makes 

me feel comfortable and that pumps my creative 

juices. There are a lot of dinosaurs, vintage objects 

and literature, and I’m listening to music most of the 

time I’m working. It’s a relaxing place.”

It certainly sounds like a lonely way to work, but 

Oliveira is often working directly with agencies and 

studios, sometimes in their work space rather than 

his own. This means that he collaborates with their 

creative teams, from the creative director to the 

copywriter. For some projects, he does have the 

freedom to direct other creatives in bigger projects, 

usually art directing or working directly with brands. 

In those circumstances he often has the chance to 

hire his own team if needed. 

Oliveira enjoys the level of freedom that Onrepeat 

has with clients and brands, it allows him to add his 

own style and input into the different briefs. He says, 

“I’m always trying to find a way to increase the 

quality and value of the projects I work on, and most 
All images© Onrepeat Studio 2015
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Onrepeat Studio is a multidisciplinary and independent 
studio founded by João Oliveira, an art director, designer 
and illustrator passionate about typography and 
experimentalism, lights and colours. João is also the 
founder of the Onrepeat Types Foundry.

ONREPEAT STUDIO
ABOUT THE STUDIO

www.onrepeat.net
@On_Repeat

João Oliveira 
Creative Director 

Rendering: Rendering a frame to test 
the lighting of the scene

My studio is a space customised to  
my creative needs and filled with 

everything that makes me feel comfortable 
and that pumps my creative juices
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of the times I’m able to add my style and input on 

them by expressing my views to the creative director 

or directly to the client or brand manager. 

Sometimes I’m even able to persuade the client in 

going through a different approach by sharing my 

view and my concepts.”

Having a personal input into projects means that 

it’s difficult for Oliveira to pin down any particular 

briefs as a favourite, as he says that he is “passionate 

about all of them”. However, one does stand out as a 

project that forced him to push his boundaries, which 

is one of his latest projects for a Spanish TV brand. It 

involved everything from the creation of the brand 

concept to the TV idents, 3D motion pieces and 

everything in between. “I had to create a wide range 

of communication tools, most of them being motion 

pieces, and direct other people as art director, from 

the 2D animation designer to the sound designer, in 

order to have my vision exactly like I wanted it to be. 

It made me start thinking in motion instead of 

thinking static and that was definitely a turning point. 

It even made me think about how much I want to 

invest more in motion graphics as a creative – it will 

definitely be a key area for me in the future.” Until 

this project, motion graphics had only been used in 

personal experiments, so the opportunity to create a 

whole branding project for a TV channel was a 

“whole new level of responsibility”. 

For Onrepeat Studios it was a whole new 

experience that could shape the way that the studio 

progresses, but it was a great learning experience, 

“The whole notion of creating a brand and applying it 

to a TV channel environment was challenging by 

itself. There are a lot of guidelines and templates that 

you have to obey. The way the information is 

displayed on the screen must be legible, organised 

D is for Dawn of The Dead: “Poster created for my I’m a Movie Character side 
project in which I’m creating a series of posters ranging from A to Z illustrating 
popular movie characters incarnated on typographic characters. This one was 
made at Halloween and was dedicated to the Dawn of The Dead movie”

Sanitana, 35 Years: One of the various pieces produced for Sanitana, a toilet material company. On this 
one the emphasis goes to the celebration of its 35th anniversary, displaying the whole range of products 

it manufactures and sells. It was used as the cover of their main catalogue

Decoration: “Those are some of the 
decoration objects I have around my studio, 
from the vintage Monsters magazine on the 

wall to the Bearbrick toy. You can also see an 
animation being rendered on the screen”
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04 RETOUCHING
After the client approved and was happy with the final render, I began 

retouching the high-resolution image in Photoshop, adding light reflections, lighting 

flares, subtle colour gradients and painting details and imperfections.

03 MATERIALS AND LIGHTING
My objective on this project was to differentiate each artist 

with distinct colours, making each piece visually appealing by using 

vibrant colours. For Bruno Mars I used blue as the main colour and 

made all the objects blue, directing all the attention to the type.

02 3D MODELLING
After that, the modelling in 3D was 

initiated and composed into the scene. Some 

changes were made and a couple of objects 

were added in order to achieve the most 

interesting composition.

KISS TV � 
BRUNO MARS
ONREPEAT TALKS US THROUGH THE 
CREATION OF THIS PRINT CREATED FOR KISS 
TV’S WITHOUT MUSIC CAMPAIGN

01 CONCEPT SKETCH
This is part of a series of typographic 

pieces illustrating the original names of famous 

artists, surrounded by objects related to them. 

An initial rough sketch was created in order to il-

lustrate the concept and establish the idea behind 

the project. Here, we have the sketch regarding 

the Bruno Mars print, where his name is built 

using a tape.
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A DAY IN THE LIFE OF JOÃO OLIVEIRA
WE TAKE A LOOK AT A TYPICAL DAY FOR ONREPEAT STUDIO

and intuitive, while at the same time remaining 

pleasant to look at, so a lot of work was made in 

order to fulfil all those important aspects.”

As well as print and digital projects, one 

off-shoot of Onrepeat Studios is an endeavour 

called Onrepeat Types, which is a type foundry that 

is proving popular. “I’m always working on side 

projects and this is one of them. It’s a side project 

focused on my fonts since I’m also a typographer. 

My first font was made in college during a 

typography class and that made me curious about 

creating even more complex fonts, which I 

eventually did. I’ve been creating some fonts for 

the past few years and I wanted to have a 

separated identity for my typographic project, give 

it its own brand and let it live – that’s why I created 

Onrepeat Types. 

“It was born at the same time I published my 

Port font, a couple of years ago. A year later I 

published its younger brother Port Vintage. I was

surprised by how successful and popular they

became when I started seeing them being used on

magazines, brands and even picked as one of the

typefaces of the Scrabble Typography Second

Edition game. I’m actually creating two more fonts

so this project will continue to grow.”

Engaging in all of these different avenues

means being on top of the latest hardware and

software. In recent times, Onrepeat’s main

10:00 EMAILS 
I start the day by checking the 

emails and planning what I’ll do. Today I got 

feedback from one of my clients, Sanitana, about a 

3D infographic I’m producing for them.

11:00 CHECK ON RENDERS
Then I check how the test render I 

started yesterday is going – it will take a few more 

hours before finishing but the animation seems to be 

fluid so far.

13:00 SIDE PROJECT
Work on my E illustration for my 

I’m a Movie Character side project, this poster will be 

about the E.T. movie.

programs have been Cinema 4D and Photoshop, 

especially where Oliveira has been focusing more 

on 3D imagery and motion graphics. “My 

production line is usually composed of Photoshop, 

Illustrator and Cinema 4D – all of them are 

essential. Illustrator, for example, is where I create 

the typographic layouts that are the foundations to 

most of my 3D projects. It’s also constantly used to 

create vector shapes to be exported to Cinema 4D, 

and used to create 3D objects, paths and shapes.” 

“Photoshop plays a big role in all of my projects as 

a post-production tool, but also much more than 

that. Recently I’ve been using it more to create 

assets, like textures, for 3D projects. It’s an essential 

tool in the production flow to polish, grade and give 

my own style to my 3D illustrations by adjusting the 

colours, adding light effects such as glows and the 

bright lights I love, and painting details that would be 

too resource-heavy to do in 3D, for example. All the 

post-production is mostly made in Photoshop and 

that’s what gives the finished look to my projects. For 

2D projects I usually use it as my main software to 

create my pieces from scratch.”

It’s hard to believe that this studio does so much 

work for big brands, covers so many creative 

avenues and is only run by one person for the most 

part. Oliveira explains why he thinks Onrepeat 

stands out from other studios, “I’ve been called 

maximalist before and I think it’s something that 

defines me very well as a creative. I have an almost 

obsessive attention to detail and I always try to 

create the best quality pieces, encompassing the 

most in a single work and always creating 

something that wows the viewer. My brain is a weird 

place and [a] busy place and that’s how I want my 

work to be, positively weird, colourful and fun.”

My first font was made in 
college during a typography 

class and that made me curious 
about creating even more 
complex fonts

Factoria de Ficción: “Still from a motion TV ident for the 
Spanish TV channel Factoria de Ficción (Fiction Factory) in 
which I was responsible for the art direction and 
production of the rebrand. This ident 
illustrates the action category and 
illustrates a police factory 
manufacturing a police car 
and chasing a black ‘bad 
guy’ car”
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TOP 5 PRODUCTION TIPS
The essential advice that keeps
Onrepeat ticking

15:00 RESEARCHING PHOTOS 
Next I work on the Sanitana 

infographic, checking the photos I took at my last 

visit to their installations. Everything must be as 

authentic and realistic as possible since it’s an 

infographic, so I’m researching all the photographic 

material I have.

16:00 ROBOT MODELLING
After the research is [done] I’m 

finally modelling one more element for the project; 

this time it’s an automated robot. With the robot 

model finished and placed on the main scene, I 

rendered the whole project in low resolution and am 

preparing to submit it to the client.

18:00 END OF DAY CHECKS
The last thing I do is check how the 

animation render is going – it still isn’t finished and 

I’m wishing I had a render farm in here but I’m happy 

with the results. Everything seems to be ready for 

the final render and tomorrow is a new day.
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■ DON’T RESTRICT YOURSELF
If a particular software is better at a specific job than the software 
you’re used to, you should take some time to learn it. Just because 
you can do everything in a single [piece of] software, doesn’t mean 
you couldn’t use another [program] to achieve better results.

■ LEARN THE SHORTCUTS
Spend time learning software shortcuts and you won’t regret it, they 
can vastly increase your production speed. From Photoshop to 
Cinema 4D, they make tedious actions way easier.

■ DON’T RUSH IT
The details are what make the difference between an alright job and 
a stunning job. The final steps of a project are crucial to dictate its 
quality and everything should be fine-tuned to perfection.

■ CALIBRATE YOUR COLOURS
Spend time calibrating your setup colours to suit your project. It 
doesn’t matter if it’s a digital or print project, you should always 
make sure your project colours are accurate and similar to the 
colours that will be printed or displayed.

■ SAVE AT KEY STAGES
This is crucial to any complex project. It’s very common for a client to 
ask you to go back to that past stage and use something from there, 
so make sure you have everything organised and ready to be used.

Photoshop is an essential
tool in the production flow

to polish, grade and give my own
style to my 3D illustrations

Literature: “Some of the books 
that can be found in my studio, 

this one is a book about type”

Kiss TV, Lady Gaga: One of the four prints produced for the Kiss TV Without Music 
campaign. A series of typographic pieces illustrating the original names of famous 

artists, surrounded by objects related to them, expressing how they would be 
known if music wasn’t part of their lives
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FROM THE BROADEST CANVASES TO THE TINIEST
DETAILS, THE HISTORICALLY ACCURATE PAST TO
THE MOST IMAGINATIVE FUTURE, THE PHOTOREAL
TO THE FANTASTICAL � BEING A MATTE PAINTER
IS A VARIED AND CHALLENGING CAREER

Matte painting for MANGO: Science fiction environments are Müller’s favourite to paint. “Once I saw Star 

Wars for the first time as a kid I was totally lost. So it’s a real joy for me when some sci-fi related project 

finds its way to my table. I also like to work [on] historic movies, because it is more specific, you need to 

be accurate and follow real historic designs, architecture, events, shapes. So you need to study a lot...

which I enjoy because it’s not only about work, you also learn something interesting in the process.”

Keep it simple: Müller says he still finds the 

pre-computer era most interesting even today 

because “old matte painters had to be real 

masters in classical artistic techniques, drawing 

photorealistic painting.” And this means he 

doesn’t like to rely on filters or plug-ins: “I‘m 

always trying to keep my workflow as simple 

and effective as I can. Even for painting I avoid 

customised brushes. What I am using a lot are 

my 3D skills. I’ve been working in 3Ds MAX with 

V-ray render for many years.”

01. BE INSPIRED AND FIND YOUR NICHE
TOMÁŠ MÜLLER REVEALS WHAT HE’S BEEN INSPIRED BY, AND HOW HE PUSHED HIMSELF TO BE A BETTER PAINTER

TECHNIQUES  25 MATTE PAINTING TIPS



02. PUT YOURSELF IN 
THE RIGHT LIGHT
When big productions are hiring matte painters, 

they’re looking for great artists certainly, but 

they’re also looking for team players. “A good 

matte painter would be able to see where things 

are off,” says Christian Kugler (www.

matteartist.com). “[They should also know] how 

long it would take to fix things, and know how to 

navigate their way around situations that really 

push limits. In terms of technical and artistic 

foundations I look for someone who knows 

whatever software they use to the best of their 

ability. They should know shortcuts or hotkeys, 

how to find the horizon and set up perspective, 

know their black levels, work as non-

destructively as possible, know how to set up 

their computer for the best workflow possible, 

know how to find good useable reference and 

source images for their work, and have a good 

attitude to go along with it all. 

“Being open to critique and knowing how to 

navigate through difficult shots certainly helps, as 

well as having a really good sense of knowing when

things look right. It is also super important to know

when to ask for help, as well as to pick up on other

techniques and ideas that can help further you

along. Observation is super important as well,

seeing how light interacts with each surface and

knowing how to balance your work out to really

make the right first impression. An individual only

has a few seconds for something to register so if

the shot does not work right off the bat, then

chances are there is something off. Learning how to

create super awesome masks is essential as well.”

© USA Network
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Finding your niche: “I was always big fan of movies and from my childhood it was pretty 

obvious that I was going to end up in some creative field, says Müller.  “I was always drawing 

and painting something somewhere... During my studies in high school I found out what 

matte painting is and I was immediately blown away by nature of this technique. It was 

something that connected my two favourite things... Movies and art. At that time I was 

mainly interested in old matte painting masters such as Albert Whitlock.” 

Push yourself: For Müller, every project is challenging in one way or another. “I love challenges,” he 

says, “Everyone wants to grow and learn to become better [and] faster... Without challenges that is not 

possible. The most significant parts of my career were always connected to projects I was afraid to take 

because I was not sure if I was capable of them. But I never regretted taking projects that were too big 

or too complex. It always pushes me beyond my current limits.”
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TECHNIQUES  25 MATTE PAINTING TIPS

03. REVEL IN
RESTRICTION

05. DO YOUR RESEARCH

“When working for movies (or even TV shows),”

says Tiberius Viris (www.tiberius-viris.com), “The

colour, perspective, mood and so on are often

already decided in pre-production and you need to

follow specific concept art and layouts. Sorry to

burst your bubble guys, but in reality more than 80

per cent of the work you will do as a matte painter

will involve bringing those concepts and layouts to

a realistic level. That means you have little creative

freedom and your success will rely solely on your

photorealistic eye and knowing how to bring a

concept to life.”

But it’s by working within those guidelines that

the matte painter can really shine.

“You usually follow a concept art or layout

pre-viz that already sets your overall composition,

perspective, colour palette,” adds Viris, “and you

also have access to sequence footage or even

precomps that give you a good idea on how

everything will work together. [It] might seem

restrictive, but working in a team is a lot of fun!”

Finding reference material can be tough: “There

are not a lot of image banks that suit the need of 

a matte painter,” explains Christian Kugler. “But 

usually for feature and commercial work, a lot of 

reference will be shot, and depending on the 

circumstances and the quality those really can 

prove helpful. If you are basing your work off a 

plate then your best reference is to always match 

the plate. That is super important for each 

project. If you are creating from scratch then if it 

is part of a sequence use lighting as a point of 

reference to help guide you along. When I first 

approach a shot and I am asked to do a concept 

or put something quick together I try to keep it 

as loose as possible without sacrificing quality. 

These days there is not enough time for revisions 

so it is best to have the closest representation to 

sell the shot as quickly as possible.”

TOMÁŠ MÜLLER’S WORK PERFECTLY DEMONSTRATES THE COMBINATION 
OF SCOPE AND DETAIL THAT GOOD MATTE PAINTING MUST HAVE

04. IT’S ALL IN THE DETAIL

01 BUILDING BLOCKS
Tomáš Müller (www.tomasmuller.com)

was inspired to create this painting, called The

Building Blocks of the Universe, by a speech in

sci-fi smash Battlestar Galactica. His workflow

always starts in the same way, with sketching and

figuring out perspective and composition.

03 GROUND YOUR IMAGINATION
“Then I’ll prepare all the photos, textures and other resources and sort them out,” says Müller.

“After that I can create 3D parts first, if there are any. Once I have 3D parts rendered I can finally focus

on painting and assembling all parts of scene together.” In this image, see how the crunchy detail in the

foreground anchors the rest of the piece.

02 RESEARCH AND 3D
Once he has a sketch that represents the

final alignment of objects in the scene, he starts

researching. “With matte work you need not only

the painting itself but also lots of photo references

and in a lot of cases you need to create some 3D.

So first of all I decide which parts of image are

going to be produced in 3D, what calls more for

digital paint and where I’m going to need photos.”
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06. LEARN FROM THE BEST
Matte painting veteran Max Dennison (www.

maxdennison.com) first came across what 

would become his career when he was at 

college and read Industrial Light and Magic: The 

Art of Special Effects. Years later he started work 

at The Magic Camera Company at Shepperton. 

He explains, “Doug Ferris was the resident glass 

painter at the time along with Roger Gibbon who 

had just started painting digitally. I used to sit 

Establishing history: When building a career, it can be
beneficial to have a speciality. “I’ve made a career out of
historical paintings, mainly ancient and medieval,” says
Cabrera, “but in no way is that my favourite thing to paint.”

Realism and narrative: If he had to describe his style,
Cabrera would say it was “realistic, having a special
focus in the descriptive and narrative/storytelling, not
so much in light and visual impression.”

Photoshop fix: Cabrera is advocate of the Layer Style menu
and the Transparency Blending Slider in that menu: “That’s
a really powerful tool for all kinds of mood and atmosphere
work. Through that tool you can add unexpected or kind of
random effects that will hopefully open new paths in the
creative process.”

Understanding: Judging when an image is done and when 
it has enough detail is a judgement call. “I think it́ s done 
when all is understandable,” says Cabrera. Painting used 
to take him anything between three and 10 days, but 
these days he is much faster.

Knights of Valour: This was Cabrera’s first step into matte 
painting for the 3D animated movie Justin and the Knights 
of Valour, for Kandor Studios. He credits Jose Maria 
Guadalupe and David Muñoz Velazquez for allowing him  
to hit the ground running.

Get started: To the young artist, interested in getting into 
matte painting, Cabrera has a simple piece of advice:  
“I would tell them to pay more attention to reality over 
photos or other artists’ paintings.”

with Doug and John Grant every day learning all

that I could and watching them work.”

“Matte painting is the art of creating the

invisible,” he continues. “I used to watch Doug

paint photoreal scenes merely using light, tone,

texture and composing shots with extraordinary

visual acuity. The Matte Painters over at ILM

(two of whom are still there) Paul Huston, Yusei

Uesugi, and formerly Michael Pangrazio for

07. ANY GENRE 
ONE OF THE BEST THINGS ABOUT MATTE 
PAINTINGS IS THAT THEY’RE NEEDED IN 
EVERY STYLE, TYPE AND GENRE OF FILM,     

© Max Dennison

© Jos Cabrera

example, would work in a similar manner and 

their work exemplifies the level to which a matte 

painter should aspire to. A matte painter should 

first and foremost be an artist. Instinctively they 

must be able to draw, they must understand 

colour, depth, light, composition, perspective and 

the visual language of film. In other words, they 

should be able to manipulate the screen to best 

effect, not just fill the canvas with detail.”

08. FOOL YOUR FRIENDS
Tiberius Viris says that anyone who wants to be a 

matte painter should work to understand 

photography. Then, when you start practising, “don’t 

go for complex fantasy or sci-fi environments and 

instead focus on set extension with real world plates. 

For example, take a photo of an existing city and see 

if you can add or remove buildings while keeping it 

realistic. Then see if you can change the time of day 

– day to night or morning to evening. [The] best way 

to check it is to show it to your friends and see if they 

think it’s a photo or not!”

“I personally think detail should be the last weapon 

in your arsenal, unless it is actually required. As 

matte painters we are creating the illusion of reality 

by trying to trick the brain into believing that what it 

sees is real. And when it comes to tricking the brain, 

detail is only a subtle, secondary accent, whereas 

light, perspective, scale and proper levels are the 

ones that make or break your illusion.”

© Tiberius Viris
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10. WORKINGWITH PLATES

Christian Kugler, who worked on The Social Network, says “Each project

has a unique set of challenges, whether it is time, money, reference, plate

quality, difficult perspective, or human error. For each one my approach is a

bit different but they all require patience and perseverance.”

Movies are a group endeavour, “Most of us work on set extensions,

patches, fixes, or being part of a sequence where the hero shot is done by a

senior artist. When you get to that level then you are able to have more of a

say about lighting and other decisions.”

Kugler explains, “Compositing is really important, so having a good

working relationship with the compositor of your shot is key in working

towards a finished version… It is essential to know that the layers are

being updated and fixes implemented.”

You must keep your artistic skills sharp. “Study the work of accomplished

matte painters and concept artists. Keep your work fresh and mix things

up. Study anatomy, colour and design, 3D, architecture and anything else

that can help give you solid foundations.”

09. WHATMAKES A GOODMATTE PAINTER?
It’s a hard question to answer, just as it’s hard to

sum up what makes a good artist of any kind. But

as Tomáš Müller explains, there are certain things

that a matte painter does need to be able to do.

“We all have our own way of how we perceive

things, how we imagine and create,” he says. “In

[the] most general sense it’s always imagination

that is most important, but for matte painting there

are also other things that matter a lot, like the

ability to look at your work and see if it is really

© Tomáš Müller
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finished or if it needs changes or improvements, 

especially in the case of projects that are supposed 

to feel photorealistic. Every project is different 

sometimes you need to use different types of 

stylisation, sometimes you have more freedom 

other times you are bounded by a strict brief. So 

versatility and ability to emulate different moods 

and styles is handy as well.

“When I do my personal works I have my own 

approach and ideas I like to visualise,” he adds. 

“With commercial jobs it’s completely different, 

because you need to follow someone else’s 

direction. So in my personal work I’m trying to 

keep it in line with my personal taste and style. In 

commercial work I’m trying to keep my personal 

approach but also offer the client exactly what 

they requested and need. I’m always happy when 

a client is open to discussion and when I can be 

part of [the] creative process behind overall style 

of shots and visuals that I am producing.”
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11. GET IT RIGHT: GET IT REAL
“Even though, over the past years, our role shifted

more and more towards 3D, I still think that the

most essential trait for a matte painter is a keen

photorealistic eye,” says Tiberius Viris, who has

Cloud Atlas and Arrow on his CV. “Understanding

depth of field, atmospheric perspective and how

light works and interacts with the environment,

are all part of what makes a good matte painter.

I use to joke that matte painters are the human

counterpart of a render engine with the added

feat of creativity!”

According to Viris, there are classic

mistakes that people make that spoil the

realism of otherwise beautiful work: “I think

the most important aspects that contribute to

the illusion of realism are perspective, scale,

light direction and black levels. If any of them

are wrong, compared to other elements

around them, the brain will immediately know

the image is fake. For example, placing a

house that is lit from the top at noon in a town

that is lit from a low angle in the evening.

TOMÁŠ MÜLLER WORKED ON
THE HISTORICAL TV MOVIE
CHATEAUBRIAND. HE EXPLAINS
SOME OF THE KEY CHALLENGES

13. THE OBSTACLES

01 BE CLEAR WHAT’S NEEDED
Your matte painting is only one part of

the puzzle. Müller says he “always needs as

much information as possible... All the technical

information about camera, optics, settings,

events happening in a scene, movement, mood

and light. There is usually a lot of information.“

03 PLAN YOUR TIME
“Usually the amount of details and

other information is discussed with the client

before start of work,” says Müller. “Production

time is very dependant on techniques used,

resolution, nature of the shot and many other

things and it can vary from a couple of hours to

days, and in some cases even weeks.”

02 DISCOVER HOW MUCH DETAIL
Müller enjoys learning when working

on historical projects, and obviously

Chateaubriand required a lot of research into

the period. He says: “Generally matte painting

needs a lot of details, especially if it supposed to

feel real. For movies I’m always preparing

matte paintings 2x bigger than the actual size

which is used in movie. That way I can make

sure that I’m able to paint and tweak even [the]

tiniest details without losing sharpness and

definition of shapes.”
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© Tiberius Viris

12. OPEN YOUR EYES
“A matte painter needs to be acutely aware of 

the world around them,” explains Max Dennison. 

“I asked my students (those who smoke) 

whether they would be able to convincingly paint 

the flame from a lighter or match seeing as it is 

only two inches from their face any number of 

times during the day. This has yet to be 

achieved… Nevertheless, matte painting, is 

about gently telling the audience a story for 

three or four seconds. If you can’t, then the 

painting has not worked. I always say to people 

who ask, that I haven’t done my job properly if 

the audience notices it.” 

You have to be acutely aware of the realities of 

digital painting too, especially the legnth of time it 

takes to complete it properly. “As I’ve got older,” 

Dennison adds, “I’ve become quicker as I know 

the tricks to get from A to B by the shortest 

means. That said, the longest time I’ve spent on a 

painting was five and a half months, which was 

painful to say the least. Nevertheless, although 

speed is a significant factor in modern day VFX 

production, it is entirely relative. What is 

important is that the painting works.” 

© Max Dennison
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14. PROJECT FROM THE BEST POSSIBLE 
Christian Kugler says, “I start by seeing if any 

concept or reference is to be used as a framework. 

After going over that with the supervisor or lead 

and production, I will come up with something that 

presents my vision of what I can bring to the table 

along the lines of what has been discussed. If it is a 

2.5D shot where there is parallax involved then 

camera tracking is needed and projections need to 

be set up. It is super important to set up your 

projections before you start painting so you can go 

forward with confidence in knowing what you are 

doing is right. Projections can either be super 

complicated, or very easy. It all depends on the 

camera movement. Whether the camera is locked 

or moving, you pick a frame, or several if it is a 

moving shot, and build your shot from the best 

possible frame. If it is a projection then you build 

your shot around the best possible frame[s] to 

project onto. After you bring that into Photoshop 

you set up your perspective and come up with a 

basic concept, or utilise something that has 

already been built. Much of the time you could 

just be helping out with a sequence and the 

shots have already been done. In that case it is 

wisest to just use as much as possible from 

the other shots as a starting point, or at the 

least a guide to point you in the right direction. 

Once you have a solid direction with lighting 

and perspective established, it just becomes a 

matter of finding good reference or shooting it 

yourself. There are many advantages of both. 

Time, location, resources, and the type of shot 

will dictate how I go about it.” 

© Christan Kugler

15. POLISH YOUR PORTFOLIO
If you want to be hired as a matte painter, you 

need to build a solid portfolio of work. “It doesn’t 

have to be official production work,” says Max 

Dennison, “but it must be matte painting, and it 

must not exhibit a slavish use of photographs.” 

He adds that the best piece of advice he can offer 

to any aspiring matte artist is “to practice and 

paint as much as possible.” But think about what 

© Max Dennison

you choose to paint too. He explains that he 

prefers to see “a simple painting exhibiting a 

thorough understand of painting. Invisibly 

removing a building from an image, replacing it 

with something completely different, rather 

than a city in the sky or a supersized 

extraterrestrial cavern or landscape. The former 

is ‘matte painting’, the latter is concept art.” 
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16. KEEP IT CLASSICAL
No matter how outlandish the subject of your images

is, like this personal work, Tincan Showdown by

Tomáš Müller, the basic rules of composition and

perspective still apply. In fact, they might be more

important, and Müller says, “I am kind of strict about

these things.” He explains: “Composition along with

light and mood are [the] most important things for

me in any work. At the beginning of each project I

spend a lot of time sketching compositions and

different points of view until I am 100 per cent sure

that what I have will work perfectly. I had a classic

artistic education and that is something I use a lot in

my work. Composition rules have worked the same

for centuries and there are good reasons why it is that

way, so it’s very helpful to take time and study all of it

before you start to do anything. Once you learn how

to use these rules without really thinking about them

then you gain incredible freedom in your work.”

If he had to offer some advice, he’d say simply, 

“Draw, paint, study, study and study again. There’s 

a lot of information and skills in the world that 

you will need to use sooner or later. For the 

commercial part of this line of work I have only 

one piece of advice: know the price of your time 

but don’t do creative work only for money. You 

need to enjoy it in the first place, but that doesn‘t 

mean you have to do anyhing for free.”

© Tomáš Müller

17. WORK OUT HOW TO INTEGRATE
The path that led Heather Abels to matte painting 

began when she saw Toy Story. “I had no idea 

about any of the different roles that go into creating 

movies, but I knew I wanted to be a part of the 

process,” she says. “Sometime after that I caught 

an episode of Cinema Secrets hosted by the late 

Stan Winston. That’s when I realised that movie 

magic was a viable career, one I was eager to 

pursue. The first time I became aware of wanting 

to be a matte painter was after picking up my first 

copy of Cinefex magazine. There was a story about

the effects in The Truman Show, and the work that

Matte World Digital did extending sets and creating

amazing backgrounds. Even after working there, 

I’m still impressed by all the work they’ve done.”

As well as being matte painting department 

supervisor at Rhythm & Hues in California, Abels 

now also teaches for www.cgsociety.org, so she 

© Heather Abels

is accustomed to explaining how matte painting 

works. She says, “Feature film matte painting can 

be incredibly complex, and the integration of all the 

elements can be an intricately layered puzzle. Not 

only do you need to know what’s going to be in the 

shot, but you and the entire team working on that 

shot need to have a plan of attack on how all these 

elements will work together. The shots I did from 

Big Miracle are the perfect example of that.”

“I had to paint the ice shelf with  
more contrast and no atmosphere 
to compensate for that 
integration, and then there was a 
period of back and forth where we 
all worked together to tweak our 
elements so the final image would 
appear as you see it in the film,” 
explains Abels.

“While I did paint the entire background 
for these shots,” says Abels, “I had to 
paint knowing that there would be a lot 
of lighting and effects laying on top of 
my painting affecting the shot and 
ultimately making it look like we were 
under water.” 

“When it comes to matte painting 
professionally, you don’t really have a 
style of your own,” explains Abels. 
“Matte painters are executing 
someone else’s vision to the best of 
your ability, but in a way that marries 
with the rest of the film, and the other 
matte painters you are working with.”

The matte paintings created for Big 
Miracle were used in conjunction 
with lighting and effects to produce 
these underwater shots.
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18. ATMOSPHERIC 
PRESSURE
ALTHOUGH BEING A MATTE PAINTER     
MEANS WORKING TO SET SPECIFICATIONS,    
A TALENTED ARTIST CAN STILL MAKE IT ALL 
COME ALIVE, AS TIBERIUS VIRIS REVEALS

Mean and moody: “I really love working on moody
scenes!” says Viris. “Playing with light, haze and colour
palettes is what makes me happy.”

Details detours: “If you look at the traditional matte
paintings up close,” says Viris, “you will notice that
most of their ‘detail’ is nothing more than blobs of
colours, however from the viewing distance they
look perfect.” Keep this in mind when you’re
creating your matte painting.

Get real: Although 3D has become increasingly important
to the matte painter, Viris believes being able to create
the photo-real is still the most important thing.

Working together: “When doing freelance projects,”
explains Viris, “it all depends on the communication
between you and the client, which is an art in itself! At
the very least you should ask to know the overall
purpose of the shot and get familiar with the sequence
it belongs to.”

Freedom beckons: Viris doesn’t often get much in the way
of creative freedom, but when he does get it, he says,
“creating moods is often the most fun part – at least for
me!. Light direction and coverage, colour palette and
atmospheric perspective usually play the biggest roles in
setting up a specific mood.”

Enjoy the view: A matte painter’s job might often be
about fixing things, but he or she is often a traditional
landscape artist too.

© Tiberius Viris

19. KNOW PHOTOSHOP 
INSIDE OUT
“Photoshop is amazing,” says Christian Kugler. 

“With recent enhancements several people could 

theoretically work on the same shot. I love the 

customisation of the brushes, and I am just starting 

to use the Brush app on my iPad. The Vanishing 

point filter is great for setting up perspective, and 

actions can really help speed your work along. I set 

up all of my repetitive tasks such as flipping the 

canvas, adding a new layer, defringing, resizing the 

image, and other helpful tasks as actions triggered 

by function keys. For my brushes I delete all of the 

ones that are not essential, as it can add a lot of 

time to sort through them all.” Your hardware is 

just as important. Kugler advises that you “always 

use a tablet, even when working in 3D, 

compositing, or just surfing the web. There is a 

saying that the pen is mightier than the sword, but 

in this case I just go with saying the pen is much 

faster than the mouse. If you aren’t used to 

working that way give it a few days or a week and 

you will see your speed greatly improve.” 
© Christan Kugler
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21. USE PHOTOSHOP,
BUT ADD EXTRAS
“The biggest change I have made to my own

workflow over the last five years or so is to paint

exclusive in 32bit float,” says Max Dennison.

“Photoshop has the singular ability to allow

users to do this without any appreciable loss of

functionality, and the processes are perfectly

suited and designed to work with ‘film’ in mind.

It seems logical on many levels that Photoshop

can do this especially as it is designed for wide

gamut, multiformat image processing.

Additionally, I employ many third party plug-ins,

which are exceptionally powerful, for instance

ProEXR, a multi layered OpenEXR file format

from fnord software allowing direct and easy

transfer of layers in 32bit float files to Nuke and

other cross platform software. This is especially

useful where importing multilayered PSD file

formats may prove too difficult. Neat Image is a

brilliant noise removal tool and Filter Forge,

although with certain limitations, is very useful

for bespoke texture production.”
© Max Dennison

20. FOLDERS AND FLATTENING
“I don’t know what I’d do without folders,” says

Heather Abels. “Keeping my painting organised in

a folder structure helps me quickly and easily

save out my painting for projection and rendering

in 3D. I also really love using proofing LUTs to

turn on and off ICC profiles to quickly evaluate my

colour when working in other colour spaces.”

© Heather Abels

She notes that when she’s working on a matte 

painting, “I need to be able to quickly flatten a 

folder, save out my file and set off a render to see 

how it’s working. This means that you can’t 

always use modes like Overlay, Screen, or 

Multiply inside a Normal mode folder, because 

they won’t flatten properly. A student of mine just 

showed me that you can attach those layers 

with a clipping mask to an adjustment layer, 

like a curve with no changes, and then it will 

flatten properly. This has been an incredible 

time saver and opened up new opportunities 

for me to paint light in ways I wouldn’t have 

attempted before!”
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22. INTO THE THIRD DIMENSION
“A good matte painter now is more than just a

painter,” explains Heather Abels (www.

heatherabels.com). “It’s no longer enough to

simply create beautiful paintings in Photoshop

these days. Matte paintings have to translate into

three dimensions, in stereo, with parallax, and in

some cases into high dynamic range. Matte

painters have to be decent environment

generalists to capitalise on the great technology

and software out there to be as efficient as

possible. A good matte painter should be able to

produce great paintings, that are organised, but it

also helps to be able to model light, texture, and

set up digital worlds as well as creating your own

digital projections.“

Abels continues that all the matte paintings she’s

worked on lately have had to work in a 3D stereo

environment. “Before I start painting I take the time

to make sure all my projections and cameras are in

place to meet the technical requirements of the shot.

This includes deciding how many layers I’m going to

need to project and organising my Photoshop file

into folders that represent those layers. I generally 

try to come up with a plan with the lighters or 

compositors so that we are all working toward a 

common goal. If there are any foreground CG 

elements, I’ll mask them out in my Photoshop file so 

we aren’t distracted by any unfinished elements. I 

make sure to organise my file in a folder structure 

that matches what I need to project on, and do a test 

render just to make sure I have the coverage I need. 

Then it’s time to paint. I try to get feedback as quickly 

as possible before polishing the details.”
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23. FROM BIG TO SMALL
“Like most matte painters,” says Heather Abels, “I 

enjoy big establishing shots, or the giant landscapes. 

Any time I get a shot that gives me nervous 

butterflies, I know I’m going to have a good time. I 

love working on architecture, and I really enjoy 

researching and painting on period pieces. Beyond 

that, I really enjoy adding the final details to shots, 

painting lighting in, creating shadows and tiny glints 

and reflections.” Knowing how much time to devote 

to the tiny glints and reflections is key. “Matte 

paintings are as varied as films and can range from 

simple projected patches to entire 3D environments 

that need to work for an entire sequence,” says 

Abels. “This means that a painting could take a 

couple [of] hours, or many weeks depending on the 

complexity and technical requirements of the shot. 

The best way to know if you are on schedule is to 

ask the producer, or your boss.” 

© Heather Abels
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25. PITCH A PAINTING
MAX DENNISON WAS THE HEAD OF MATTE PAINTING FOR WETA ON THE LORD OF THE RINGS 
TRILOGY. HE EXPLAINS HIS APPROACH TO A NEW MATTE PAINTING

Holistic approach: “I’m not sure I have a style,” says 
Dennison, “but I expect that others might say that I do 
considering that I can tell other painter’s work a 
mile off. What I try to achieve is a holistic approach to 
my work. Design is my starting point. I mock up very 
quickly a rough [version] of my matte painting,” 
he explains of his work. 

In your mind’s eye: “Some clients are very happy with a first 
pass,” says Dennison, “but others like to explore a range of 
options first. However, my process is to describe a concept as 
‘shot on film’. What I mean is that the concept should strictly 
adhere to the same rules as the final painting. Perspective, 
colour, composition, lens and photographic constraints, and 
most importantly exposure are vital as this stage.”

Rough it up: This loose rough version, created “with a thick 
brush in Photoshop gets me efficiently onto the right track,” 
says Dennison, “but it also allows the client to approve 
something and buy into an idea before too much effort has 
been employed. Design is a collaborative process and client 
involvement at this stage is very important.” 

Invisible objects: “I’ve painted a lot of things in my time,” says 
Dennison, “planets, cities, castles, skies, clouds and so on. But 
I guess I prefer to paint things that are natural and invisible. 
The greatest enjoyment is to know that I’ve fooled the 
audience and kept them suspended within the story.” 

A vision to follow: Dennison explains that “Nine times 
out of ten, we will have a live plate – the live action 
component which has been shot by the production. 
Additionally, we might receive some concepts or layouts 
from production or editorial which are loosely put 
together with the director’s approval.”

Freedom to create: “Other times,” he continues, “we will get 
nothing except a loose description of the shot: ‘... A mountain, 
with some snow at the top and a lush jungle at the bottom’. 
The latter method, for me, is probably the best as it allows the 
matte painter to express their own unique creativity. With an 
artist’s instincts and foreknowledge of what will work in such 
a situation, the matte painter can conjure up something far 
more visceral and believable...” 

© Max Dennison

24. PUT THE DEVIL IN THE DETAILS
Colour, perspective and detail are all key when it 

comes to professional matte painting. “Colour and 

perspective are derived from reality,” explains Max 

Dennison. “Perspective is either right or wrong and 

the audiences’ eye will very quickly pick that up. 

Colour comes from nature. If you research your 

theme well, you’ll be able to put the right colour in 

the right place at the right time.” But how much 

detail to put into an image often stumps even 

talented artists. “This needs to be done with good 

judgement, experience and an awareness of 

screen space,” Dennison explains. “Often, students

of matte painting will labour for days or even 

weeks filling the screen with unnecessary detail. 

However, the eye is extraordinarily intuitive. A good

matte painter can lead the eye around the screen 

©
 M

ax
 D

en
ni
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n

and keep it in one position for the entire length of 

the shot. That means that you only put detail into 

those areas where the eye travels. Everything else 

is superfluous. I once watched Doug [Ferris] and 

John [Grant] at Magic Camera ‘muddy’ up a 

colleague’s painting after he had left for the night 

because it was too crisp with detail which 

ultimately wouldn’t photograph correctly.”  
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MATTE PAINTING FROM PHOTOS  TECHNIQUES    

LEARN HOW TO WORK WITH FRAGMENTS OF
PHOTOS TO CREATE A FANTASY SCENE

MATTE PAINTING 
FROM PHOTOS

L earn how to use Photoshop to create a

fantasy scene with this tutorial. We’ll start

with creating a sketch. Try to experiment

with different ideas and choose the most

interesting option. It’s important to think through all

the details before you start work. We will combine

fragments of photos to create a background and

unique objects to create a fantasy environment.

Creating scenes isn’t easy when you’re working with

different source photos. You will need to use colour

correction elements and effects so that the image

becomes attractive and convincing. You will also

PREPARING THE BACKGROUND
USE MULTIPLE IMAGES TO CREATE A BACKGROUND

learn how to manually create sunlight and shadows, 

as well as achieve uniformity across all elements.

In order to successfully complete this tutorial 

you’ll need a base knowledge of Photoshop. We 

will be using different tools, such as selection 

tools, layer masks and adjustment layers, colour 

corrections (Curves, Color Balance, Selective 

Color and more) and brushes. Use a pen tablet if 

possible – using a mouse will make the process 

longer and more difficult. This tutorial has been 

completed with Photoshop CS6, but you can use 

most other versions.  

01 CREATE THE SKETCH 
The first step is to create a new 

document: File>New, set document size to 

2,950x4,200px. Then create a sketch. At this 

stage it is important to make a decision on 

composition and the location of all objects in the 

scene. Think through all the details before you 

start work; you will need to decide on the overall 

colour of the image and light sources.

02 MAKE THE BACKGROUND
Open the image ‘IMG_02-1.jpg’ and cut the 

mountains with a Lasso tool, and then move them 

onto your scene and scale accordingly. Duplicate this 

layer and modify the shape, remove borders around it 

with soft Eraser tool, and merge into the scene. Then 

select Image>Adjustments>Curves, lower the 

contrast and add more blues and lower the saturation 

using Hue/Saturation. Note that the further away the 

object is, the less details you should see.

03 ADD THE SKY
Use images IMG_03-1.jpg - IMG_03-5.jpg to 

create the sky. Cut out sky fragments and add them 

to your scene. Then select Edit>Transform>Warp and 

change their shapes as needed. Now make the sky 

more consistent by selecting Curves and adjust the 

brightness, contrast, and colour for each element. 

Use the Eraser tool with soft edges and Clone Stamp 

tool to eliminate seams. Merge these layers and 

slightly darken the upper portion of the image. 

FROM IDEA TO FINAL IMAGE

WORK IN 
PROGRESS

Progress 1: Sketch the scene

Progress 2: Add basic objects

Progress 3: Final touches

NADEGDA MIHAILOVA
www.nm-art.weebly.com/

OUR EXPERT

Nadegda Mihailova is a digital artist 
and creative retoucher from Russia, 
specialising in environment 
illustrations. Milhailova is currently 
working as a freelance digital artist. 

SOURCE FILES
All the photos used in this image can 
be downloaded free via FileSilo
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TECHNIQUES    MATTE PAINTING FROM PHOTOS

04 THE LANDSCAPE
Insert the mountains from IMG_04-1, 

IMG_04-2 and IMG_04-3.jpg to your scene. Add more 

blues using Color Balance and lower the contrast. 

Create a new layer then draw some fog in the right of 

your scene using a light-blue Brush tool with soft 

edges, on 10% Opacity. Paint the mountain edges and 

peaks with the same brush. This should add more 

consistency to the entire scene. Add the forest 

(IMG_04-5.jpg), the bridge (IMG_04-4.jpg), and the 

grass (IMG_04-6.JPG) in front of the mountains. 

Adjust brightness, contrast, and colour for each 

element by using Curves, Color Balance, and Hue/

Saturation for the desired result.

05 FORM THE TOWER
Create the tower shape out of stone 

textures by cutting stone texture fragments from 

images IMG_05-1to IMG_05-4.jpg. Use Transform 

and Warp to change their shapes and sizes. Make 

brightness and colour consistent among all the 

fragments. Now draw a spiral on top of the tower. 

Merge these layers and “heal” the seams with Clone 

Stamp tool. Select the Brush tool with soft edges, 

change the blending mode from Normal to Multiply, 

set Opacity to 10-25% and darken the bottom and left 

parts of the tower. Add the riverbank from IMG_05-1.

jpg to the right side, then select Hue/Saturation and 

reduce saturation and lightness.

06 ADD DETAILS
Cut out elements from IMG_06-1.jpg (1) 

and place balconies around the tower. Make the left 

and right sides darker and the central part of the 

balcony lighter. Then repeat to create the second 

balcony. Place the window from IMG_06-2.jpg (2) 

in the center of the tower. To add smaller windows 

use IMG_06-3.jpg (3), adjust Color Balance and 

Curves to make the windows’ colour and 

brightness consistent with the stone texture. Make 

the window sides’ upper and lower parts darker. 

Decorate the tower facade with elements from 

IMG_06-4.jpg (4). Reduce the brightness by adding 

reds and yellows using Color Balance.

07 TOP OF THE TOWER
Create a new layer and draw ridges (1). 

Take a colour sample from the stones. Place the 

pattern from IMG_07-1.jpg under the ridges (2). Then 

select Transform>Warp to change the shape as 

needed. Adjust brightness, saturation and colour for 

all added elements. Add shadows on the left and 

under the ridges using a brown soft brush in Multiply 

mode with 10-20% Opacity. Copy the small windows 

from the previous step and place them on the tower 

(3) then add decorative stone elements (IMG_06-4.

jpg) to the tower facade.

08 BOTTOM OF THE TOWER
Use elements from IMG_08-1.jpg to create columns and add them to the facade. Select Image> 

Adjustments>Hue/Saturation to decrease saturation and lightness. Use IMG_08-3.JPG to create the gates and 

place them under the layer with columns. Use Curves to decrease the brightness then add yellows and reds. 

Copy the balcony and place it between the columns, reduce its brightness. Place the stone elements 

(IMG_08-2.jpg, IMG_06-4.jpg) and windows (IMG_08-4.jpg) on the tower. Add the bridge (IMG_08-5.jpg) and 

draw stairs on the right side of the bridge. Adjust brightness, contrast, and colour for these new elements.

    QUICK TIP 

Use adjustment layers as clipping masks for 

editing elements. This means you will have the 

opportunity to go back and edit part of your 

image – you can weaken or strengthen the 

impact if necessary.
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12 LIGHTS ON THE TOWER
Create new layer and fill it with black. Select 

Filter>Render>Lens Flare from the menu, set Lens 

Type to 50-300mm zoom and apply the filter. Change 

the layer blending mode to Screen. Transform the 

layer by scaling it down and squeezing it a little. Place 

a flare onto the tower top then add flares to smaller 

towers in a similar way. To enhance the glow create 

new layer, set blending mode to Overlay, Opacity to 

50-70% and add stamps around the flares on the 

towers with a big light-yellow soft brush.

11 ADD PLANTS  
Add plants IMG_11-4.JPG, IMG_11-5.JPG 

behind the tower then reduce brightness, contrast, 

and saturation. Place the plants from IMG_11-1.jpg, 

IMG_11-2.jpg, IMG_11-3.jpg on the tower surface, 

adjust their brightness and colour balance. Create a 

new layer, change its blending mode to Soft Light 

and set Opacity to 30-50%. Create a clipping mask on 

the layer with plants. Go over the plant edges with 

brown soft brush. Then create a new layer under the 

plants, set blending mode to Multiply and Opacity to 

20-30%. Paint shadows under the plants. 

13 BUILD THE ROCK
Copy the gates from the main tower and 

paste them onto the rock and reduce contrast. Now cut 

out part of the stone texture to create the bridge. Use 

Warp Transform to change the shape as needed – 

erase any unnecessary areas. Then make the right and 

bottom parts of the bridge darker. Add columns from 

IMG_13-3.jpg (1), reduce their brightness, add reds and 

yellows using Color Balance and make the bottom part 

darker. Insert windows from IMG_13-1.jpg (2) into the 

rock. Use IMG_13-2.jpg (3) to create the top of the 

building. Adjust the brightness and colour of these 

elements to make them consistent with the rock. 

10 CREATE SMALL TOWERS
Create small towers in a similar way. Copy 

the stone texture from the main tower and change 

its shape as needed using Warp and Transform. 

Draw the spiral and tower peaks. Then add building 

fragments from IMG_10-1.jpg, reduce brightness, 

and add yellows and reds using Curves. Insert the 

tower top, IMG_10-1.jpg then adjust colour. As in 

step 09, adjust light and shadows for more visible 

volume. Merge the layers related to the small tower, 

duplicate the layer and place it above the left balcony. 

Make it darker and erase the bottom part. Use 

images IMG_10-3.JPG, IMG_10-4.jpg to create the 

remaining small towers.

09 ADD MORE VOLUME
Select the layers that relate to the tower and merge them. To add more volume, create a new layer, 

change this layer’s blending mode to Multiply and set Opacity to 30-40%. Use clipping masks, so that you can 

apply effects to only this object. Right-click on the layer and select Create Clipping Mask. Use a soft brown 

brush to darken the bottom and left parts of the tower as well as areas under the spiral. Increase shadows on 

the windows and brighten the central part of the tower using a Curves adjustment layer.

ADDING MORE ELEMENTS
CREATE THE TOWER AND OTHER ELEMENTS FROM FRAGMENTS OF PHOTOS

Do not forget to adjust 
brightness and colour for 

all the elements you add
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FINAL EDITING
FOREGROUND AND THE FINISHING TOUCHES

TECHNIQUES    MATTE PAINTING FROM PHOTOS

QUICK TIP

Use layer groups to optimise your work. When

you have too many layers, working with them

can become difficult. It can be convenient to

group layers that relate to each other. Select the

layers and press Cmd/Ctrl+G to group them. You

can also apply adjustment layers to the group.

HIDE THEDRAWNELEMENTS

When you draw the small details, it is important

that they do not stand out among photorealistic

elements. To disguise them create a new layer filled

with 50% grey and set the blending mode to

Overlay. Create a clipping mask then go to

Filter>Noise>Add Noise, and set Amount between

1-7%. Go to Filter>Blur>Gaussian Blur and set

radius to 1-2 pixels. Or place a suitable texture

instead of noise, reduce saturation, set the layer

mode to Overlay or Soft Light then adjust Opacity.

14 WATERFALL AND RIVER
Use IMG_14-1.jpg to create the riverbank 

under the rock (1). Reduce brightness and add 

blues using Curves. Cut out water texture and 

paste it in the river. Select Hue/Saturation to 

decrease saturation of yellows then add blues 

using Color Balance. Add the waterfall from 

IMG_14-2.jpg (2) and adjust its brightness and 

colour. Now use IMG_14-3.jpg and IMG_14-3.jpg 

(3) to form the lower part of the riverbank. Change 

the rocks’ shape as needed using Warp. Use Hue/

Saturation to reduce saturation of reds and yellows. 

15 CREATE THE FOREGROUND
Place the rocks from IMG_15-1.jpg in the 

foreground. Create the lower part of the rocks from 

the fragments of IMG_15-2.JPG and use the Clone 

Stamp tool to remove seams then merge these 

layers. Draw the entrance in the upper part and 

extend the bridge so it reaches the gates. Then 

duplicate the bridge to create the second one, place it 

to the right and reduce the brightness. Add the ladder 

from IMG_15-3.JPG and add plants on the right side 

of the riverbank with IMG_11-3.JPG. Do not forget to 

adjust brightness and colour for all the elements you 

add. They should be consistent with other the 

elements in the scene. 

16 ADD MORE SHADOW
Now add more volume and depth as well as 

focus the viewer’s attention on the tower. First, add 

more shadows. Remember that the light source is 

coming from the top right. Create a new layer and 

change its blending mode from Normal to Multiply; set 

Opacity to 50-70%. Use a dark coloured brush, not 

black, and add more shadows to the left side of the 

tower, lower part of the riverbank, the areas behind the 

tower and to some of the foreground. Add shadows to 

the small elements and plants. 

17 HIGHLIGHTS
Create a Brightness/Contrast adjustment 

layer, set Brightness +60 and Contrast +20. Invert the 

layer mask using Cmd/Ctrl+I and paint darker areas 

inside it with a soft brush using white. Add flares to 

the central parts of the tower, tower tops, bridge, 

waterfall, landscape on the right, and to the 

foreground. You can lower the adjustment layer 

Opacity to 80-90% to make it weaker. Add a new 

layer with blending mode set to Soft Light and 

Opacity to 50-70%. Select a light-orange colour and 

add coloured flares using a brush.

18 THE FINAL CORRECTION
To add more depth to the image, reduce the contrast of the background. Create a new layer and using 

a light blue soft round brush, Opacity 10%, paint over the background and behind the tower several times. This 

will add more depth and separate the tower from the background. Now you will need to add more consistency 

to all the elements. Try to experiment with adjustment layers for Solid Color, Gradient Fill, Gradient Map and 

various blending modes and Opacity. I selected a blue Solid Color and set blending mode to Soft Light and 

Opacity to 15-30%. Then select Gradient Fill, set colour to orange and set blending mode to Overlay in order   

to enhance the sunlight coming from the right. To finish, add more contrast using Curves.



photorealism
“MODO was the perfect solution for this project. With 
its realtime preview, I was able to instantly see my 
lighting and material setups, which was key to blending 
the CGI with the photography. Plus, its super fast 
render speeds helped me meet my very tight deadline!”

Mike Campau 
Creative Director / Digital Artist
WINNER PHOTOSHOP WORLD GURU AWARD 2014 - COMMERCIAL
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PRO SECRETS FOR THE PERFECT RETOUCH  TECHNIQUES    

LEARN HOW TO CREATE A BEAUTY RETOUCHED
IMAGE, WITHOUT OVERWORKING THE DETAILS

PRO SECRETS FOR 
THE PERFECT 
RETOUCH 

F rom smoothing out the pores to removing

the fine details, beauty retouching is easily

overworked – don’t find yourself caught in

this trap. The key to success is often leaving

some impurities, and letting the natural beauty come

through. True success comes from a balance

between perfection and imperfection.

When you are working with the details, don’t

forget to work in an overview as well. Zooming in

and out as you go will help refocus your attention

and draw you to more pressing issues that you need

to correct.

The type of portrait you are working on will dictate

the type of details that will need to remain. For

RETOUCH THE MODEL
START WITH BASICS LIKE CLONING, COLOUR AND TONAL CHANGES

example, in beauty retouching anything distracting 

needs to be taken out. However, in portrait retouching 

where the subject is known, then any birthmarks 

identifying the subject must remain. Sometimes it 

becomes difficult to decide what needs to stay in, or 

come out, what is an imperfection and what is a 

distinguishing, characterful feature.

As with any retouching, keep the viewer’s eye 

focused on the areas that are most important. Keep 

them engaged in the subject, and interested in the 

imagery. Keep your work grounded, and create the 

perfect image. Remember, you will have done your 

best work when no one knows you have done 

anything at all.

01 ADOBE CAMERA RAW
When you open the Raw file in Photoshop, it 

will open with Adobe Camera Raw. This will allow 

you to make any general colour and tone changes. 

Make sure the printable area is large enough for the 

final print size. Be sure the image preferences (blue 

text under the image) reflect a size that is large 

enough to print with.

02 WHEN TO CROP
Ensure that you work on, and archive, the 

full image. Cropping can happen later, at the end of 

the project. One day you may need a different crop 

of the image. Therefore, it makes more sense to 

start and finish at its full size. Cropping for a 

website or print is much easier after the work    

has been completed. 

03 OPEN IMAGE OR OPEN OBJECT
When finished, either click Open Image, 

or hold down the shift key for Open Object. When 

using a Smart Object on the Raw file, you will be 

able to freely jump between Photoshop and 

Camera Raw. Working this way will preserve 

your original Raw settings, should you want to 

edit them again later. 

FROM STUDIO TO FINISHED
RETOUCHED PORTRAIT

WORK IN 
PROGRESS

Progress 1: Technical Changes

Progress 2: Detailed Work

Progress 3: Refinements

JOHN ROSS
www.TheArtofRetouching.com
@ArtofRetouching

OUR EXPERT

John educates photographers 
and retouchers by helping them 
expand their creativity through 
Photoshop, from his website and 
the classes he teaches from New 
Haven, Connecticut.

SOURCE FILES
On FileSilo, you can find the model 
and iris images. Any additional 
images and brushes for references 
can be found at www.deviantart.
com and www.shutterstock.com.
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TECHNIQUES    PRO SECRETS FOR THE PERFECT RETOUCH 

QUICK TIP

Remember that it is an easier workflow to tackle the technical issues first, like perspective, de-noise and 

sharpening. Follow up with issues like tone and colour second. Only after is when you should focus on the 

retouching details like cloning, dodge and burn, and other light-sculpting techniques. 

04 USE GUIDES
Once in Photoshop, use guides to check that the perpendicular 

and other lines of symmetry are even and balanced. It’s best to do these 

types of technical corrections before getting into the details of actual 

retouching. It can become frustrating after doing all that work, only to 

realise the tilt of the camera is distorting something. What could have 

been one layer of correction, later requires many layers be fixed. With 

proper planning, extra work can be avoided. Use Edit>Free Transform for 

any general corrections. 

05 SHARPENING
For greater control, do your sharpening in Photoshop with Filter>Sharpen> 

Smart Sharpen, preferably on a separate layer or Smart Object so you can mask out 

areas as needed. This will allow for sharper eyes, but softer hair and background. This 

image is quite sharp, but you may want to add a little something to it. Some prefer to 

sharpen as a first step, others prefer it to be last – it’s up to you. Set the Amount to 

150%, Radius to 1.0px, and Reduce Noise to 0%.

06 LIQUIFY FILTER
Once again, as part of fixing the technical 

issues first, use Filter>Liquify and the Forward Warp 

tool to push in the ears, as they are hanging out too 

far. Also bring the hair down on the right side as it 

appears too high. Lower the right shoulder as well 

so it is a bit more even with the left side. Because of 

the camera lens, she appears to have an elongated 

forehead. Use Liquify to bring her hairline down. 

Lastly, her chin can be dropped a bit lower as well.

07 TONAL CHANGES
It’s easier to fix the technical issues like 

perspective, noise, and sharpening first. Target these 

types of items before thinking about the minor 

blemishes. There is extra work in fixing these after 

you have already started cloning. Tonal Range and 

colour are also general items that might need 

adjusting. This image only needs some contrast. Use 

Layers>New Adjustment Layer>Curves to make a 

simple S-shaped curve to boost the contrast a little. 

The overall colour is already correct right out of the 

camera because of the proper lighting.

08 SMOOTH TEXTURES
A common area of correction is the lighting 

on a model’s skin. This image appears to have 

over-detailed pores with the lights and shadows 

across her forehead. Create a duplicate layer and 

use Surface Blur with a Radius of 7 and Threshold 

of 5 to remove the shine’s excess contrast on her 

forehead. You will also need to create a Layer>Layer 

Mask>Hide All. Click on the black layer mask and 

use a white brush to reveal the effect exclusively   

on her forehead. 



047

12 WHITES OF THE EYES
When it comes to cleaning up the whites of 

the eyes, the best tool is the Spot Healing brush. 

When set to Content Aware, it will remove the minor 

blemishes like the veins without much trouble at all. 

This is because it works great in these types of 

small, tight spaces. Use it sparingly though, as it has 

a tendency to smear the pixels and make things look 

worse. Keep the curved gradients, and be sure not to 

make the eyes pure white, as they will look strange. 

11 LEAVE IMPERFECTIONS 
Contrary to what you may think, it’s best to 

leave some imperfections. They will help the 

believability of other areas that would otherwise look 

too polished. Common areas to keep in mind are 

birthmarks, eyebrows and hair. Choose the right 

imperfect areas to leave in a balanced, orderly 

fashion. When done properly, they will go unnoticed, 

and yet add a believability that will allow the viewer 

to accept the remaining areas as fact.

13 DARKENED EYES
There are many different styles when it 

comes to retouching the iris. While some prefer 

them to remain dark, beauty retouching often 

requires them to be bright and colourful. However, 

the lighting may be too dark, or reflections in the 

eyes may not give the best results from the existing 

iris. With this image, the eyes are very dark, and also 

have the reflector showing at the bottom. This is 

when you need to use a similar coloured iris, but 

shot much brighter to reveal all the details. 

10 CLONE WITH THE HEALING BRUSH
When satisfied, you can get started on the

cloning of the skin. Using a small Healing Brush, at

about 8px, will yield great results without

sacrificing the details in the skin. For professional

work, skin cloning can take an hour or significantly

more. Just take it slow and steady. Rushing or

using a big brush can lead to repeating patterns or

blotchy skin areas. This is where most of your time

should be spent. As a first pass, focus on the larger,

most obvious blemishes.

09 MACRO BEFORE THE MICRO
Don’t just work on one topic at a time. Keep moving around and fixing things as you go. If you do all 

the skin work at once, you will likely do too much. By using multiple layers for each pass, you will have 

greater flexibility when it comes to revising previous changes. 

WORK ON THE SKIN
REMOVE THE BLEMISHES WITH CLONING AND HEALING 

001 PREPARE FOR SUCCESS
Start with getting the technical details right. It’s best to do
things like sharpening and alignment before getting into details

002 MAKE GENERAL CORRECTIONS
Adjust the tone and colour with adjustment layers before
giving the image a first round of cloning and healing

003   FURTHER ENHANCEMENT
Add depth to the image by correcting the eyes, lips, eyelashes 
and eyebrows before another round of healing the skin

004   THE PERFECT PORTRAIT
Work on the details, removing even the smallest flaw. Leave      
a few minor imperfections to help make it look real

001

003

002

Your work will be at its best 
when no one knows you 

have done anything at all
004
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REFINE THE DETAILS
CREATE THE PERFECT PORTRAIT 

VIDEO TUTORIAL

Retouching portraits involves many different

steps, and comes in many different styles.

Fashion, beauty, and studio are just a few of the

different ways portraits can be retouched. Each

one has its own unique look and feel. Would you

like to view a behind the scenes video of how this

image was actually created? With the link below,

you will be taken through all the various steps,

layers and techniques involved with creating this

image. Please go to www.TheArtofRetouching.

com/APM132 for more details.

14 REPLACE THE IRIS
Use the Iris.tif image included on FileSilo, 

and drag the eye layer onto the portrait. Set the eye 

layer to 75% Opacity, and scale to fit. Bring the 

Opacity back up to 100%, and apply a layer mask to 

paint in the areas you want to use, while concealing 

the rest. Use a Curves adjustment layer on top to 

adjust the density as desired. You will want to flip 

the iris for the other eye or rotate so that the 

pattern is not the same.

15 RETOUCH THE LIPS
For the lips, you will want to keep the 

details, only soften them. Duplicate the background 

layer and use a simple Gaussian Blur of 3px. Use a 

Pen tool to define the outline shape, then turn it into 

a selection with 5px feathering. After applying the 

selection to a layer mask with a Layer>Layer Mask>

Reveal Selection, you can paint in and out the 

existing details as desired. With another layer on top, 

you can also paint in more shine by using a brush 

with different opacities.

16 COLORIZE THE LIPS
With brushwork for the shine, and cloning 

to even the outline, the depth and shape are 

created. Mix up the lipstick colour with Layer>New 

Adjustment Layer>Hue/Saturation. By enabling the 

Colorize checkbox, it’s easy to try many different 

colours in seconds. You may use the same mask 

as before by holding the Cmd/Ctrl key and clicking 

on the layer mask previously created around the 

lips. Click on the Colorize button, and choose a 

colour that you think looks best.

17 FIX THE EARS
Because the ears are so thin, any light from 

behind will give them a red cast. The easiest way to 

correct this is by using the Lasso tool with a 10px 

feathering to trace around the ears. Then go to 

Layer>New Adjustment Layer>Selective Color to 

create the new adjustment, and apply your selection 

as a layer mask. With the colour, select the reds, and 

depending on previous adjustments in Camera Raw, 

adjust the cyan to be +8, magenta to be -21 and 

yellow to be -11.

18 DEPTH OF FIELD
When the image allows it, get a little creative. On the background layer, apply an Iris Blur of 15px. 

Make it centered on the bridge of her nose, and large enough to come halfway through her hair. This does 

three things. First, it adds depth of field around the back of the model’s head and gives visual interest. Next, it 

eliminates excess details below the shoulders that could be distracting. Finally, it greatly reduces the amount 

of time needed to remove random flyaway hairs.

BEFORE

AFTER

TECHNIQUES    PRO SECRETS FOR THE PERFECT RETOUCH 
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QUICK TIP

What facial features need to be kept, and which

should be removed? When faced with

imperfections in beauty retouching, take them

out. The same imperfections in portrait

retouching might be left in. Be careful what you

take away though. Temporary blemishes can be

removed, but lifelong marks should be retained.

21 ADJUST THE EYELASHES
For the eyelashes, set your brush to a size 

of 3px and hardness of 80%. Select a dark grey/

brown colour from the existing lash area. Open 

your Window>Brush Palette and select Brush 

Dynamics. Change Control to Fade, set to 40. This 

will allow you to draw in some additional 

eyelashes, filling in the spaces. Adjust the value of 

40 to be higher or lower as needed. You may also 

want to adjust the brush Opacity as well. When 

finished, be sure to change Control back to Off. 

22 CORRECT THE EYEBROWS
You may find that the eyebrows need

refinement as well. Before starting, look at some

images to find examples of what well-manicured

ones look like. Use this as reference while you work.

Various techniques can be employed. Often, you will

want to use the Clone Stamp to remove any random

hairs to help define the overall shape. Similar to the

eyelashes, you can use a brush to paint back in

missing hairs. This time you can make the Fade

much stronger, like 100px.

23 FINE DETAILS
A true test of patience is the final detail

work. Now that the image looks mostly complete,

rest a few minutes, then come back with fresh

eyes. As you correct the image, the more other

areas become obvious. Which sections look

over-worked, and which ones still look undone?

Decide if anything still looks uneven. Removing

darkness under the eyes and other discolourations

pixel-for-pixel can get very tedious. But it’s this high

attention to detail that will make your work stand

out from everyone else’s. 

24 ADD EYESHADOW 
Something retouchers need to do once in a while is to add extra makeup. It helps if you have some 

training, even if you are male! Like anything else, it is a skill and an art that requires practice. To add some 

eyeshadow above her eyes, use a Hue/Saturation adjustment layer like you did for the lips. Using the same 

techniques described earlier, softly paint on the layer mask with a 20% Opacity brush set to 20% Feathering, 

and reveal the shade of colour you created. 

19 ELIMINATE BLEMISHES
In a previous step you worked on general

cloning for the obvious blemishes on the skin. Now it

is time to go back in and do some more, but with a

finer level of detail. Start cloning on a new blank

layer, and move around the skin with the Healing

Brush to eliminate the some more of the blemishes.

Try to avoid making the image look overly

processed. Leave some impurities, so that the

overall results will look more natural.

20 DETAILED CLONING AND HEALING
It’s time to really evaluate the finer skin-related issues. The best results will likely come from zooming

in at 200%-400%, and using a 1-3px Clone Stamp brush at 10% Opacity; your source being a light area, and your

destination being a darker pixel. By slowly lightening the darker pixels, you will gradually lighten the overall

darker section. Do the same with overly bright pixels. Source a darker area, and slowly build up the density.

Doing this at a professional level is incredibly time-consuming, but worth the effort.

BEFORE

BEFORE

AFTER

AFTER
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   FRESH TYPE TECHNIQUES   TECHNIQUES    

TURN OVER A NEW LEAF AND LEARN HOW TO 
BREATHE SOME LIFE INTO YOUR TYPOGRAPHY

FRESH TYPE 
TECHNIQUES

P erhaps it’s the fact that I grew up in

England’s favourite retirement town, but I

have a particular affinity for old things. This

love extends to furniture and graphics, but

most of all, to people – after all, older people are

exponentially far more interesting than anyone my

own age. But while I’ve loved the modern retro and

vintage design trend that has been going strong for

the past 10 years, I’ve always stayed away from

simply pastiching the past. Much like older people,

modern designs inspired by bygone days aren’t

interesting because they are an exact replica of

PAINTING THE BACKDROP
CREATING A BACKGROUND FOR YOUR TYPE

history but because of the way they have adapted the 

sensibilities of the past to work with the modern world.

In this tutorial, we are going to take typography that 

is more commonly seen on old painted wall adverts, 

ghost signs, and splice it with the very 21st Century 

trend of moss graffiti – also known as guerrilla 

gardening. Using Photoshop’s extremely powerful 

clipping mask and layer mask functions, we are going 

to create a fresh typography that straddles two time 

periods separated by decades and yet ends up looking 

like neither. So before we grow too old before our 

time, let’s get started!

01 BRICK
Painted brick is considered architectural 

heresy but for the purposes of this image, we’ll 

allow it. The background needs to be clean and 

fresh so that the type stands out but at the same 

time it should appear slightly grungy so that the 

image looks natural. Drag an image of a 

whitewashed brick wall into your new canvas. 

02 CO
It’s likely that the brick wall image will not 

fill up the entire canvas. To extend the brickwork 

image, select the layer and draw a boundary using 

the Polygonal Lasso tool in the areas where you 

would like additional brick. Select Content-Aware 

under the Fill command, Edit>Fill, and Photoshop 

will add additional brick areas using the current 

image. Digital witchcraft.

03 BRIGHTNESS
Now that the canvas is filled with brick, 

adjust the brightness settings, Image> 

Adjustments>Brightness/Contrast, so that the wall 

appears bright and clean but retains enough 

contrast so that the texture of the brickwork and 

the pointing can still be read. If you require more 

control over the brightness, you may find it easier 

to change the Levels settings, Image> 

Adjustments>Levels, instead.

A FRESH TAKE ON
TRADITIONAL TYPE

WORK IN 
PROGRESS

Progress 1: Set the scene

Progress 2: Add embellishments 
to standard fonts

Progress 3: Create 
eco-graffiti

www.andyhau.com
@andykwhau

OUR EXPERT

I am a London-based architect and 
designer and the owner of A.H.A 
Design. For me, design is an escape 
from the futility of modern life, not 
an endorsement of it.
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QUICK TIP

Photoshop’s Content-Aware Fill command is probably the closest thing we have to magic. However,

when it goes wrong, boy, does it go wrong. The command tends to work better on smaller areas so

where possible, try to reduce fill areas by discreetly copy-and-pasting existing content.

04 CHOOSING FONTS
Pick a  sans-serif and a serif font that 

will work well together. Futura and Lobster are a 

good choice as they both have a retro-tinged 

aesthetic but more importantly they don’t lose 

their legibility when you start adding effects to 

them. You can do this part in Photoshop by using 

the Type tool but I find that Illustrator gives you 

far more control, which makes it easier to modify 

the text in general. Adjust the tracking, Window> 

Character in Photoshop, to change the spacing in 

between the letters.   

05 EMBELLISHMENTS
A serif font such as Lobster is beautiful on 

its own but to really give the illusion of a ghost sign 

mural, it needs a little help. Use the Pen tool in either 

Illustrator or Photoshop to add embellishments and 

swirls to some of the letters. Unfortunately, there 

isn’t an exact science to this. It’s really about studying 

the letters closely and seeing where opportunities 

for embellishments lie. The goal is to have enough 

embellishments for the letters to flow but not so 

many that they distract..

06 THE SUN AND WOODLAND CRITTERS
Rather than simply re-creating a traditional 

ghost sign, we are going to give the impression that 

the text has been created with a spray can and 

stencil. To help with this illusion, we need spray-

painted silhouette images integrated into the text. 

Much like Step 5, use the Pen tool in either 

Photoshop or Illustrator to create the silhouettes. If 

you are using Photoshop, hold the left mouse button 

to create curves. You can change the curves by 

holding Cmd/Ctrl and moving the handles.

07 ARRANGEMENT
If you’ve created the text and images in 

Illustrator, select and drag these objects into your 

working Photoshop canvas. Change the size of the 

text and images as necessary and Rasterize these 

objects by selecting the layers in the Layers panel, 

right-clicking on them and selecting Rasterize Layer. 

Arrange the text so that the composition looks 

balanced and the text is easily legible. Place the 

silhouette images playfully within the text. However, 

make sure that the location of these images does 

not conflict with the legibility of the text.

08 COLOR OVERLAY
Once you are completely happy with the location of the text and images, select all the layers that 

contain the serif fonts (and any associated image layers) in the Layers panel, right-click on them and select 

Merge Layers. Double-click on this new layer and select the Color Overlay option in the Layer Styles panel. 

Choose a zingy fresh colour that will complement the lush green moss graffiti. It will be difficult to change the 

colour later on so make sure you’ve picked the right colour! 
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12 LAYER MASK 
Select the serif font layer in the Layers 

panel and go to Layer>Layer Mask>Hide All. Then 

either using Photoshop’s Spatter brush or a spray 

paint brush that you can download from the 

internet, start painting on top of the mask layer, 

using white for the colour to reveal the text. If you 

are using Photoshop’s own Spatter brush, be sure 

to play with the Scattering and Shape Dynamics 

options in the Brush Panel to create a more 

realistic spatter and flow. 

11 NOISE 
Select the serif font layer in the Layers 

panel, right-click on it and select Rasterize Layer 

Style to “flatten” the outlines into the layer. To re- 

create the stippled effect of spray paint, we need to 

add some noise, Filter>Noise>Add Noise. Depending 

on the size of your text, change the Amount setting 

to approximately 10%. Click on the Gaussian option 

for the Distribution and untick the Monochromatic 

option. The effect will appear quite stiff and 

unrealistic at this point – don’t worry, this is normal! 

13 SA
If you haven’t already, make sure that your 

sans-serif font is Rasterized by right-clicking on the 

layer and selecting Rasterize Layer. Drag the moss 

texture into the Photoshop canvas and resize the 

texture so that it covers the text entirely. Making sure 

that the moss texture layer is above the sans-serif 

font layer on the Layers panel, right-click on the 

moss texture layer and select Create Clipping Mask. 

The texture should show through the text. Resize the 

texture layer if it seems too big relative to the text.

10 OU
To make the text stand out further,

double-click on the serif font layer in the Layers

panel and select the Stroke option to give the text

an outline. Change the stroke size to an

appropriate size – depending on the size of the

text, this can range from 10px to 20px. Change the

stroke colour to a lighter colour that complements

your text colour. The outline around the blurred

text will also add to the illusion that the colours

are bleeding into each other.

09 BL
The colours in a spray-painted mural often bleed into the background. To recreate this effect, 

start by selecting the serif font layer in the Layers Panel, right-click on it and select Rasterize Layer Style. 

Then select Gaussian Blur, Filter>Blur>Gaussian Blur. Change the radius setting accordingly – this can be 

anywhere from 3.0 to 10.0 pixels depending on the image size. 

WEATHERBEATEN PAINT EFFECTS 

001   BRICKWORK
A white painted brickwork texture was 
chosen to help the text stand out, while 
still maintaining a slightly grungy, 
weathered look

002   TEXT
A serif font was chosen and 
embellished with additional swirls and 
silhouettes to create a more natural 
and handmade appearance

003   SPRAY�PAINT EFFECT

modified and noise will be added 
to achieve a spray-painted and 
stencilled feel

001

003

002

The goal is to have enough 
embellishments for the 

letters to flow but not so many 
that they distract
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GUERILLA GARDENING
CREATE LUSH AND VERDANT TYPE

QUICK TIP

When revealing the text through the layer mask with the spray can brush, be brave and trace the word in

one go, touching up only where necessary afterwards. This creates a much more natural and flowing

finish – being too conscientious will make the results look stiff and artificial.

TIE COLOURS TOGETHER

Hand lettering is all about balance and flow, which

is often hard to recreate when using standard fonts

which tend to be rigid and prone to logic. A font

with plenty of ligatures, such as Lobster, will help

to soften its appearance but in order to fully fool

the eye, you will need to study hand lettering in

order to decide which letters require additional

swirls and embellishments. If you are creating

something where accuracy and alignment is not

too important, you can also distort the text ever so

slightly using Edit>Transform>Distort to break up

the rigidity of the text.

14 DROP SHADOW
To create presence and to make the text 

really stand out from the background, we need to 

create a very subtle Drop Shadow underneath the 

text. Double-click on the sans-serif font layer and 

select the Drop Shadow option. I’m not really a 

believer of “less is more” but in this case, it really 

does apply! There only needs to be a very slight hint 

of shadow so turn the Opacity level to around 30% 

and play with the size settings so that the shadow 

appears convincing.

15 INNER SHADOWS
We need to create depth and fullness to 

the text. Double click on the sans-serif font layer 

and select Inner Shadow. Lower the Inner Shadow 

Opacity to around 30% and increase the Choke and 

Size settings until the text starts to have some 

dimensionality. With the Layer Styles panel still 

open, select the Bevel & Emboss setting. Decrease 

the Highlight and Shadow Opacity setting to give 

the text a subtle roundness. Don’t worry if it still 

looks a little flat, we will go back and manually 

sculpt the text later. 

16 DEFORM THE EDGES
Adjust the Hue/Saturation Image> 

Adjustments>Hue/Saturation, to give the texture 

more of a lush, verdant appearance. To deform and 

soften the edges of the text, click on the sans-serif 

font layer and choose a small Hard Round brush. 

Slowly go round each letter and paint small circles 

on the edges to expose more of the moss texture. 

You can do this in an ad hoc manner or you can try 

and follow the natural growth patterns in the texture 

to create a more convincing illusion.

17 HIGHLIGHTS AND LOWLIGHTS
Select the Polygonal Lasso tool. With a high 

Feather setting, approximately 50px, select the areas 

where you want your shadows to be on the text. With 

these areas still selected, click onto the moss texture 

layer and decrease the Brightness setting, Image> 

Adjustments>Brightness/Contrast, to really intensify 

the shadows and create dimensionality. With a lower 

Feather setting, approximately 10px, select the areas 

where you want your highlights to be. This time, 

increase the Brightness setting to produce 

neon-bright areas of light.

18 FINISHING TOUCHES
Zoom out so that entire image fits onto your 

screen and check that you are happy with the overall 

composition of the image. There should be a natural 

flow that leads your eye from the start of the 

sentence to the very end without being distracted.   

To introduce some dynamism, you can create some 

paint spatters using the spray-paint brush or 

Photoshop’s Spatter brush in the corners of the 

page, however don’t let it overtake the image.

TECHNIQUES    FRESH TYPE TECHNIQUES
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In my opinion, and my 
traditional training has 

certainly inspired me in this 
way, it is fundamental to lay 
[down] the major elements 
as soon as possible



KITSUNE
CLÉMENT SAIONI

F or digital artist Clément Saioni (www.

clooms.deviantart.com), one of the most 

fundamental aspects of creating personal art

is combining technical knowledge with a 

narrative space. “As a consequence, I get a large 

depth of field,” Saioni goes on to say, “and precisely 

because this is a major preoccupation for me, I start

with a rough painting using different levels of grey.”

“In my opinion, and my traditional training has 

certainly inspired me in this way, it is fundamental to

lay [down] the major elements as soon as possible.” 
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TECHNIQUES   HOW I MADE

03 HARDER BRUSHES 
I changed to harder brushes and increased 

their Opacity to get a more palpable fabric. In the 

background, I set a few lights using the brush with 

scattering in order to represent moss and bark etc.

DISCOVER HOW THIS TRADITIONALLY TRAINED ARTIST HAS BROUGHT 
HIS COLOUR AND COMPOSITION SKILLS INTO DIGITAL PAINTING

Saioni then goes on to say, “That’s why I deal with 

the colour relationships between the character and 

the background afterwards: once this is established, 

I can then work on the harmony more easily, and 

add just about anything without getting serious 

colour awkwardness.”

To create his latest piece, titled Kitsune, Saioni 

referred to Japanese mythology as well as its 

current popular interpretations, creating a piece that 

would reflect a challengingly meditative subject – a 

pause in time. 

01 BLOCKING OUT 
I started with a black and white rough piece 

using a brush with a loose gesture to get quite a 

picture-like result. I didn’t think of how readable the 

picture was, but rather focused on the composition 

and the energy of movement in the picture.

02 COLOURS AND HEADS
Taking examples from several pictures, I 

drew the fox’s head and laid down the colours that 

would make up the basis of the picture as a whole. 

Then, I set the character’s head, since it will be at 

the core of the final picture – every element must 

be in keeping with it.

“In order to guide the spectators’ eyes and 

minds to penetrate the picture, the foreground 

must almost be palpable - that’s why I added 

some plants at the end of my work, which I 

hope would help to feel the non-visual 

sensations. This is really hard and I still have a 

lot of progress to make, but if looking at the 

picture makes you feel the coolness of the 

grass and the softness of the wind, then my 

aim has been achieved.”

GUIDE OBSERVERS INTO THE IMAGE WITH 
MAKING THE UNCANNY REAL
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TECHNIQUES   HOW I MADE

06 ADJUSTING LEVELS 
With the Levels settings toolbar I brought 

some contrast back on the leaves at the top of the 

picture. I did the same to reduce the dark parts of 

the faraway landscape so as to respect the 

atmospheric perspective. I finished this 

modification up with some brushstrokes.

04 LIGHTING AND TREES 
I now matched the lights of both the 

background and the foreground. Next I used a 

Soft Light layer to represent the shadows of the 

leaves on the tree trunk, then unified the 

middle-ground colours so that the trees wouldn’t 

be highlighted too much.

05 LEAF DETAILS 
I added the leaves to suggest the idea of 

movement and time. Then, I laid [down] a bright halo 

with a very soft round brush on a Hard Light layer at 

less than 30% Opacity.

07 PAINTING THE FOREGROUND 
I added a foreground in order to draw the 

spectator’s eye into the picture. Then [I] decided to 

paint a plant and to duplicate it through a copy-and-

paste manipulation. Next, I transformed the copied 

plants through Warp. I used the brush again to 

correct the small light errors and single out each leaf 

through tiny modifications.

08 FINAL DETAILS
To finish, I added a halo (lens flare). I then 

brought some blue back to the background in order 

to make it a more readable space, through an 

Overlay layer. Then I laid down some clusters of 

pollen that I got through a textured brush and finally 

a Gaussian blur.

“The Kitsune helps to inject manifestations of 

magic through the representation of autumn,” 

explains Saioni. “My goal is to achieve the idea 

that the uncanny permeates reality as a whole 

in the spectators’ minds. I think it’s culture’s 

role to create mental bridges between what 

can and can’t be.”

THE KITSUNE
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REDESIGN A SITE  TECHNIQUES    

LEARN HOW TO RECONSTRUCT CONTENT AND USER
EXPERIENCE WHEN YOU REDESIGN A WEBSITE

REDESIGN A SITE

E ven if you think you planned for everything,

and it seems to be a perfectly thought out

user experience, it can get lost when

attention to certain details falls short. The

practical approaches for designing better UX cover

mobile apps, adaptive systems, and multiscreen

experiences. Explore the strengths and weaknesses

of infinite scrolling, and take a look at how well

crafted feedback loops can influence a user’s

behaviour. Consider mobile UX, take the index

fingertip into consideration as the user’s navigation

tool, and focus on the information, rather than just

impressing the user with design.

This tutorial will take you through how to design

a better, more modern user experience, thinking

REVIEW AND PLAN YOUR DESIGN
LOOK AT WHAT EXISITS THEN WORK ON THE WIREFRAMING

about reconstructing content and modules from an 

existing website, and how to lay it out with a simple 

wireframe before starting to design the UI work. 

Discover what you should think about while 

designing the content for multiple screens and 

devices, as well as adding your own gimmicks to the 

user experience and interface design. All you need 

to complete this tutorial is Photoshop for setting up 

your web design layout, and Illustrator to create 

icons and design decals for the user interface. 

Wireframes can be achieved in any software or 

online tool you feel comfortable drawing in. 

Personally I would definitely recommend  Go 

Mocking Bird (www.gomockingbird.com) as a 

great tool for wireframes.

01 REVIEW EXISTING CONTENT AND UX
Let’s start out by reviewing the current 

branding, colours, modules and sections before we 

start to reconstruct the new UX. Think about how the 

content can be easily discovered by the eye, and how 

it can be cleaned up. How can the interface offer the 

same features and content in an exciting way, but at 

the same time keep the amount of content intact? 

02 UX AND WIREFRAMING 
I started out by wireframing and 

reconstructing the current front page content of the 

website. The key focus was doing something 

scaleable, responsive and creative for the header 

theme, and having the important modules stick up 

from the bottom for the user to review and discover 

as a second attention pull-in.

03 SET UP PHOTOSHOP FOR WEB DESIGN 
I normally design in 1600px width, including 

a 60px bleed on both sides of the page. Make sure 

your dpi is set to 72; don’t worry, all icons and logos 

in this tutorial will be Vector Smart Objects and SVG 

 ready. I’m also going to give it a good height since 

the front page will have a lot of content stacked 

underneath the main cover header. 

WIREFRAMES, COMPING,
FINAL

WORK IN 
PROGRESS

Progress 1: Develop and work 
on the wireframes

Progress 2: The front page 
interface design

Progress 3: Create cool 
decals and icons

ROLF A JENSEN
www.rol� ensen.no

@rolfajensen

OUR EXPERT

Rolf A Jensen is an international 
award -winning Norwegian art 
director, former designer and 
co founder of Good Morning, 
currently working as a contractor for 
Microsoft, Avid International, 
Watson/DG and Urbandaddy. 
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QUICK TIP

Always keep the copy and paste workflow between Illustrator and Photoshop close at hand. Copy and

paste a vector (SVG-ready object) from Illustrator to Photoshop as a Vector Smart Object. This mostly

applies to graphics and icons. Typography and basic square shapes can still be made in Photoshop as

they’re easy things for the developer to re-create himself in CSS.

04 DESIGN THE HEADER GRAPHICS 
After setting up your document, start to 

design the header images. Since [at the time of 

writing] the most recent cover topic from Advanced 

Photoshop was selection tools, I chose to create a 

template story based on this subject, including 

creating decor in Illustrator that fits the subject to add 

to the imagery. Copy (Cmd/Ctrl+C) and paste (Cmd/

Ctrl+V) them into your Photoshop document and place 

them in a fitting position.  

05 ADD FUNCTIONALITY
After spending a few minutes in Illustrator 

to create a few interesting selection decals, move on 

to the functionality graphics such as navigation, 

social outcalls, article title and action button. I used a 

font called Lato (www.google.com/fonts) for the 

entire website. You’re welcome to play with this as 

you please, it won’t really affect the overall workflow. 

Open the logo in Illustrator, select and copy and paste 

it back into your Photoshop design – to make sure 

it’s possible for your developer to easily convert. 

convert it to an SVG (Retina and smartphone-ready 

graphic). Always make sure all your graphics are 

Vector Smart Objects, besides basic background 

shapes and fonts that are easily done in CSS. 

06 CONTENT MODULES IN FOCUS
Moving on to the next section of the 

website, we have some of the most important 

modules popping up from the bottom of the 

browser window and re aligning themselves based 

on window resolution. This helps the user 

understand that there’s more content to be 

discovered if the website is scrolled, so it’s a key 

factor to make it work in the CSS cross-platform. I 

took the existing gallery and artwork modules from 

the website and placed them with a dynamic 

background graphic, which changes based on the 

latest submission or editor’s choice [image]. The 

shortcuts modules underneath are simply links that 

lead to the latest articles posted by an admin in that 

specific category – it’s handy to have on the top as it 

would change often. 

07 ARTICLE MODULES
The first thing landing on the grey background, after the top content, is a mix of all latest articles and 

tutorials with thumbnails and labels. Include a ‘More’ button leading to a list view, sorted by dates, of all 

archived articles. Again, while doing the list view on the button, make sure the icon is made in Illustrator, and 

pasted into Photoshop as a Vector Smart Object. The green button could just be done as a raster shape 

straight in Photoshop; it could easily be remade with pure CSS later, and would not need to be an SVG file. 

08 NEWS SECTION
I chose to do the news section fairly simply, 

just including the date, title and introductory text. 

Since we already have the article section with 

thumbnails I didn’t want to visually overload the front 

page with more thumbnails. The news items would 

work more as a blend of tweets and updates rather 

than full articles and tutorials.
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12 MOBILE DRILL DOWN 
Besides stacking the content underneath 

each other, make sure that the smallest fonts are 24 

points. I used 36 points for titles and buttons. Make 

sure to save the design in 750x1334px (if you are on 

an iPhone 6 or similar) and see how it feels to touch 

the buttons and read the fonts in the design. 

11 DESKTOP TO MOBILE 
Converting the design to mobile is fairly 

simple, since we designed everything in a 4x grid. It’s 

more or less a matter of stacking the modules 

underneath each other and scaling up icons and 

fonts to be more visible for the smaller mobile 

screens. A rule of thumb I go by often is to have no 

fonts underneath 24 points; most of the time it’s just 

annoying for the eyes to read them, and since this is 

a website packed with articles and goodies to read, 

let’s make sure it’s easy to soak up.

13 MOBILE NAVIGATION
The navigation element of the website is 

done by the classic hamburger icon, that expands the 

full navigation into a full-screen mode and turns the 

hamburger into a Close button. I also included the 

Log in and Sign up buttons on this screen to save 

space on the mobile front page. The social media 

outcalls are placed at the bottom with the intention  

of having them available as a part of the navigation 

element, a section the user will frequently open. 

10 TWITTER POOL AND FOOTER 
I placed the feed from Twitter at the bottom 

of the website, simply because it’s not a module the 

regular user visiting the website would look for. The 

content is simply less relevant than the user and 

editor-driven artwork modules. The footer is a 

simplified version of the existing website footer with 

less content, which is narrowed down to Advanced 

Photoshop related features more than global 

Imagine Publishing features.

09 ARTWORK CATEGORIES
Towards the bottom of the website, I chose to follow the structure of the current Advanced 

Photoshop website, but I minimised the amount of gallery modules on the front page, and kept everything in 

one module. Introducing the most popular and active gallery category entries, including a count of total entries 

in each category and a View Full Gallery index icon. The user would also be able to discover more and less 

popular galleries by clicking on the More button underneath the thumbnails.  

DESIGN THE INTERFACE
CONSIDER THE WEBSITE’S USER FUNTIONALITY 

Make sure to save the 
design in 750x1334px (if 

you are on an iPhone 6 or 
similar) and see how it feels to 
touch the buttons and read the 
fonts in the design
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CREATE ICONS AND DECOR
ICONS AND DECOR ARE IMPORTANT TOOLS FOR USER INTERACTION

TECHNIQUES    REDESIGN A SITE

QUICK TIP

Drag one section over from your original desktop design PSD to your mobile PSD and scale the elements 

up directly in the new document. Don’t spend time on redesigning everything from scratch. After all it’s 

mostly a matter of restacking it and rescaling fonts and icons. 

BE AWARE OF DPI

Keep in mind that all illustrations you are doing

for the icons should be kept to a two point

thickness, since that’s used on the lines

throughout the website already. Make the DPI of

your Illustrator document, that you are using for

creating your icons, the same as your Photoshop

setup. Although many tablets and smartphones

have higher resolution screens than this, it’s still

the standard for web designs, principally because

the smaller file size means that page elements

load quicker. If you do need to scale up any of 

your illustrations, make sure that they’re Vector 

Smart Objects so that they can be scaled up 

without losing clarity. 

14 MOBILE ICONS AND IMAGERY
Make sure that all the imagery used is 

saved in double the pixel size from your original, to 

make sure it won’t turn out blurry on screens with 

higher dpi than 72. I scaled up my Vector Smart 

Object icons from a 25px radius to a 50px radius, 

simply to make it more comfortable for the smaller 

phone screens with higher dpi.

15 DECOR AND DETAILS 
Making a clean and sophisticated interface, 

but keeping it creative with its own gimmick, is often 

hard. Sometimes just placing a few additional 

graphical elements into the UI is enough. I thought 

placing the initials of Advanced Photoshop behind 

some of the top content sections would be a nice 

touch. I also placed in additional lines and graphics 

on the article/tutorial page, which you’ll see in the 

next thumbnail. This gives a more arty touch to the 

tutorial page. 

16 TUTORIAL ARTICLE
Doing a sample of the tutorial page, I chose to 

focus on giving it a more magazine-like layout simply 

to keep the user more visually interested while 

scrolling down the content and reading the tutorial. 

Each of the steps would be labelled from left to right 

going down, including a title and introductory text 

featured on the top of the page. 

17 VIEWS, ACTIVITY AND COMMENTING 
The lower part of the tutorial page shows 

the popularity of the article in a simple graph. There 

is also a user comment section that allows 

registered users to comment and share their 

thoughts and feedback on the article. 

18 FINAL DECOR
I added some final decor to the interface to 

make it more than just a simple interactive 

magazine layout, with a signature style of illustration 

and the Advanced Photoshop initials. Know your 

balance when it comes to these details, don’t kill the 

balance of the page, just add that little extra 

something that shows that you care about the details 

and finding your own gimmick. Since it’s interactive, 

you can always have your developer place these in 

CSS, so they slide behind the front content when the 

user scrolls down on the page. 
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HYPE
BRANDON KOCHER

B randon Kocher (www.behance.net/

HalfLife) is a self-taught student at Florida 

Gulf Coast University, focusing on graphic 

design, photo manipulation, vexel 

illustrations and 3D typography. This personal 

typographic piece was created so that Brandon could 

experiment with new techniques to make his 

typography more expressive by using abstract 

shapes and patterns. Created in Photoshop CC, it 

uses the Pen as the main tool to create the bold 

shapes and structure of the piece. 

“The image started with the flat text of the word 

‘Hype’,” he explains. “Each letter is then filled with 

Pen tool shapes that each have a shadow and 

highlight around the edge for depth. The other blue 

effects around were added with soft brushing set to 

Linear Dodge or Screen around the edges of empty 

Pen tool selection shapes.”

FIND OUT HOW THIS YOUNG DESIGNER BUILT THIS BOLD 
TYPOGRAPHIC PIECE USING THE PEN TOOL AND BLENDING MODES

01 STARTING TEXT 
This is the basis for the typography piece. Since it is one short word I know it’s going to have a lot of 

tedious layers within each letter, [so] I made each letter a separate layer and spaced them to my liking. 

Effects were added with 
soft brushing set to Linear 

Dodge or Screen around the 
edges of empty Pen tool 
selection shapes

TECHNIQUES   HOW I MADE
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02 PEN TOOL SHAPES 
Each letter was [coloured] with 

gradient-filled Pen tool shapes, with added 

highlights and shadows to give them form. I also 

added extra shapes around the letters and stroked 

Pen tool lines set to Linear Dodge to start adding 

in flow to the text itself. 

03 FINAL DESIGNS 
To finish the piece, I added the flowing 

blue shapes. They were made by making a 

selection with the Pen tool and adding layers of 

low Opacity white/blue soft brushing around the 

edges, set to Linear Dodge or Screen.
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COMBINE 3D AND PHOTOSHOP  TECHNIQUES    

LEARN HOW TO CREATE INTERESTING
ILLUSTRATIONS COMBINING BASIC 3D
RENDERS AND STOCK PHOTOS

COMBINE 3D 
AND PHOTOSHOP

Y ou don’t have to be a master of 3D graphics

to be able to use 3D to your advantage

while creating 2D illustrations in

Photoshop. In this tutorial we will look

closely at the process of mixing different digital

techniques in order to create a stunning,

atmospheric sci-fi illustration. Along with different

Photoshop tips and tricks, we are going to focus on

what is most important in any kind of creative

work; composition, lighting and the different parts

of art theory that help us to come up with images

that are full of atmosphere and are well-balanced

COMING UP WITH A BALANCED COMPOSITION
THINK ABOUT YOUR CREATION AND SKETCH BEFORE STARTING WORK

in terms of visual content. Custom brushes and 

plug-ins are not the only thing you will need to 

create really professional visual creations, it’s 

always helpful to look back at classic art theories 

and mechanisms that have been used for centuries 

too. There’s a lot of software around us, with 

Photoshop being the main program for creating 

visual content. Let’s take a look at how to 

incorporate other software and techniques in 

Photoshop to create even more complex artworks 

– from the first sketch through to building your way 

from a basic 3D render to a final visual full of details. 

01 START WITH COMPOSITION
This illustration will have a central 

composition, which was picked purposefully 

because it’s harder to work with. It’s challenging 

to balance the composition and avoid making it 

look boring and static. There was an additional 

challenge of possibly incorporating the magazine 

title into the composition while maintaining a 

nice flow and balance in the illustration itself. 

02 EVERY PART HAS ITS PLACE
On this image you can better see the main 

elements and their placement, which breaks up the 

central composition. Additional spherical parts and 

other details of the bomb are placed in the ‘golden 

points’ near the horizontal and vertical thirds of the 

image, pushing the viewer’s focus away from the 

centre. Foreground parts are added in at an angle, 

which also helps to break the composition apart and 

make it more dynamic. 

03 LET THE LIGHT BUILD THE IMAGE
Another important part of the composition 

is the flow of light and colours between background 

and foreground. As you can see in this particular 

scene, there is an amount of light decreasing 

towards the foreground and on top of that there is a 

mist created by the background waterfall – here 

objects are disappearing with increasing distance 

from the camera. This also enhances the fluid 

composition and adds depth into the scene.

FROM SKETCH TO FINISHED
ILLUSTRATION

WORK IN 
PROGRESS

Progress 1: Digitally  
painted sketch

Progress 2: Raw 3D elements

Progress 3: Final illustration

TOMÁŠ MÜLLER
www.tomasmuller.com
@Tomas__Muller

OUR EXPERT

Tomáš Müller is a well known CGI 
artist, matte painter and retoucher, 
working for a wide variety of clients 
and studios from different corners of 
the creative industry, such as 
advertising agencies, photographers, 
game developers and many more.

SOURCE FILES
Explore the layered PSD file and 
learn how the 3D and photo 
elements were created and textured. 
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TECHNIQUES    COMBINE 3D AND PHOTOSHOP

QUICK TIP

While sketching, keep everything simple. Once you have a sketch you like, then you

can try to enhance your sketch with a few textures or photos. This will give you a

clearer idea about the final look and amount of detail you’ll include.

04 SKETCH, SKETCH AND SKETCH AGAIN
Sketching is a crucial part of image development, so don’t be 

afraid to spend time sketching and figuring out all parts of the illustration; 

composition, the design of each element and the colour scheme. In this 

case, the final image has changed a lot compared to the concept sketch. 

There is no need to follow every tiny part of your sketch, it is mainly to give 

you ideas about what you want and don’t want from the final image. 

05 MASTER PAINTING WITH DEFAULT BRUSHES
Photoshop has a lot to offer and lot you can add to it. But try to master default 

brushes and functions rather than relying on plug-ins and customised brush sets. After 

all, sketching is about your ability to draw. That, unfortunately, can‘t be substituted by 

any filter or automated function. Custom functions may increase your abilities once 

you know how to draw things by hand, but your sketches are not going to look any 

better just because you use texture-based brushes. This first draft sketch was created 

using only default Photoshop brushes.

06 START WITH SIMPLE SHAPES
This bomb shape started with just a grey 

circle. Shadows and highlights were painted on top of 

it with a default Soft Round brush. This might seem 

simple but it’s hard to create complex shapes 

without the knowledge of how to paint basic objects. 

Once you know how to paint basic geometrical 

objects it‘s a lot easier. It‘s similar to when animators 

are practicing by trying to put life into a ball bouncing. 

Simple often does not mean easy! 

07 MASTER THE DETAILS
Now we will look at using photos to add 

detail to an image. As you can see on the image, 

there is texture and a few added details. In this case 

we are using a stock photo of a naval mine. To 

re-create this effect just put the desired photo on top 

of your painted object, then switch the photo layer to 

Soft Light or Overlay. Then select Filter>Other>High 

Pass, on the layer with the photo. The amount of 

Radius on the High Pass equals the amount of detail 

that becomes visible. Use the slider inside the filter to 

find the desired amount of detail and apply. 

08 ADD COLOUR TO YOUR SKETCHES
Keep your sketches defined in terms of 

colours. It will help you to avoid unnecessary 

changes that could appear in the final stages of 

work, as a result of not having clear ideas about 

colours from the very beginning. As the image 

shows, even one Selective Color adjustment layer 

and one layer set to Overlay with a few soft green 

brushstrokes can give you at least a rough idea 

about your chosen colour scheme. 
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12 ADD THE DOWNPOUR 
Another nice detail to add is dripping water. 

In real life, water mist would condense on cold metal 

and pour down in the form of droplets and small 

streams. In order to create this effect you can either 

paint droplets and streams by hand or use photos of 

dripping water on a black background like we did in 

this case. White water, black background – with this 

setting you can just switch the water layer to Screen 

and paint the water itself by using the Clone Stamp 

wherever you need it to be.

11 LET IT GROW
The next additional detail is moss on top of 

objects and grass below them. Grass is painted by 

hand with a 2-4px brush (the thickness of the brush 

depends on the resolution of the image you are 

creating). Moss is painted using the Clone Stamp 

with a default round brush. A stock photo of 

spherical moss is used to make sure that it follows 

the shape of the bomb spheres. From that point all 

the moss is hand painted with the Clone Stamp set 

to 50% Opacity and 50% Flow. 

13 PLAY WITH THE TINY DETAILS
Even the tiniest details matter, even those 

that are not visible at first sight. There is no need to 

overdo your image or fill it with thousands of objects, 

but some small additions here and there can 

increase the look of the whole image or add small 

hints of backstory or the functionality of objects. 

There are small illegible texts and textures added in 

this step to make the viewer wonder what could 

happen next or what the story of the scene is about.

10 RUST IT UP
Rust and leaking dirt is added to the image

using stock photos and textures of real leaking and

rusting metal. Adding textures is simple, just use

different blend modes like Screen, Multiply and Soft

Light. Depending on the brightness of the additional

textures, bright textures are best set to Screen and

dark stains to Multiply. Always check the shape of

the object that you apply texture on, and make sure

that the texture is following the shape of the object

correctly. Use the Warp tool to make the texture

follow shapes and edges.

09 ADD SOME REALITY TO YOUR DESIGN
Now we can take a look at how to enhance our 3D elements with additional details such as 

moss, dripping water, rust textures, leaking water and foliage hanging below the main objects. Always 

think about what the scene you are creating would include in real life. What kind of weather does the 

scene have and how it would affect objects in the scene? 

TEXTURING THE 3D PARTS
ADD DETAILS AND ADDITIONAL TEXTURES TO YOUR RENDERED PARTS

001   ADDING RUST
The scene is full of water and
humidity, so all metal parts 
should be rusty and dirty

002 GRASS AND MOSS
In forests near water there is always
some amount of moss present, so it 
should be added on 3D parts as well

003 DRIPPING WATER
Water should be also dripping from the
objects, because water condenses on 
the surface and pours down

001

003

002

Always think about what 
the scene you are creating 

would include in real life
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FINISHING THE SCENE
BUILD YOUR WAY UP TO THE FINAL IMAGE

    QUICK TIP 

The High Pass filter, Filter>Other>High Pass, is a 

great way to sharpen all sorts of images or even 

just parts of them. Duplicate the layer or object 

you want to sharpen, switch the blend mode of 

the layer to Soft Light and apply the filter. The size 

of the Radius affects the amount of sharpening. A 

general rule is to keep it low, unless you’re 

looking for a heavily over-sharpened look. 

    PERFECT THE IMPERFECTIONS

As mentioned in step 17, lens flares and effects 

like these are all products of the imperfections in 

manufatured optics. Our minds are so used to 

seeing these artefacts in images that our brains 

perceive them as reality. Photographers try to get 

rid of these effects to make their photos more 

perfect, while CGI artists add them to make their 

works more realistic. One of the effects worth 

mentioning is grain. Don’t be afraid to use grain 

and other imperfections on top of your images to 

make them feel more rough and genuine.

14 THINK AHEAD AND BUILD UP
It’s always a good idea to proceed 

systematically with building up your layered scene. 

Try to find a good starting point which gives you the 

advantage of seeing what you need to do to add to or 

improve the image. After some time spent looking at 

the image you start to lose the ability to perceive the 

image from a distance and see things that need or 

don‘t need to be done. So think ahead before you 

start compositing. In this case, we are building our 

image from background to foreground.

15 CREATE AN ATMOSPHERE
Having created the background at the 

beginning will help you see if other parts in front of it 

fit with the scene conditions, such as lighting, 

atmosphere and colours. Every enviroment is 

affected by surrounding light from the sky and sun, 

as well as light bounced back to the scene from 

different surfaces or additional artificial light sources. 

When you have the main mood and background set, 

focus on ensuring everything else corresponds with 

it. Try to achieve a fluid blend of elements while 

avoiding obvious cut-outs.

16 FINISH THE SCENE
Now, when we have all the main parts 

present and building up the scene itself is finished, 

we can focus on colour grading and the final steps of 

postproduction. As you can see, the finished 

composite already has a good atmosphere; the base 

flow of colours and light works already. Systematic 

build-up paid off! But the overall colour scheme is a 

bit monochromatic and it is apparent that it could be 

pushed further in terms of colour variety and mood. 

Let’s see how far we can push the image. 

17 PLAY WITH THE LIGHTING AND EFFECTS
To increase the realistic look of light sources 

in the scene, we can add all sorts of effects produced 

by light and camera lenses in real life, such as spot 

light, glow, lens flare, chromatic abberations and 

glare. As you can see on this image, the montage is 

switched for solid black colour so you can see clearly 

how all the light effects are composited. It’s very 

simple to add them in, for instance a lens flare that is 

generated on a black background can be added 

simply by switching its layer to Screen and adjusting 

for the desired opacity.

18 FINAL COLOURING AND ADJUSTMENTS
Here you can see the image with final 

colour grading. Grading was done selectively one 

small step at a time. Don’t be afraid to use many 

adjustments layers and masks to deliver the exact 

colour and feeling you need. There is no need to do 

all of the colouring in at once, so take your time, 

adjust all objects and colour tones one by one, look 

away for a moment to gain visual distance and then 

look back at the illustration again. This allows you 

to see more clearly if the image needs more 

adjustments or not.

TECHNIQUES    COMBINE 3D AND PHOTOSHOP
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CREATIVE PROFESSIONALS SHARE THE SECRETS 
OF HOW TO BUILD ENGAGING USER EXPERIENCES 
THROUGH GOOD DESIGN FUNDAMENTALS, AND 
EXPLAIN HOW PHOTOSHOP IS AN ESSENTIAL 
PART OF THE PROCESS 

NEW MEDIA

N
ew media is one of those terms that 

covers a whole multitude of applications 

and has differing definitions depending on 

what you’re reading, or even what day of 

the week you’re reading it. Its meaning is as 

changeable and adaptable as the technology it is 

describing. 

New media, in its simplest terms, is related to the 

internet and the way that sound, graphics and motion 

interplay and converge with each other to provide a 

rich user experience. Of course, it’s not just the 

internet any more – it’s apps, social games, 

installation projects, interfaces and more. And the 

good news is, Photoshop has a tool for pretty much 

every part of the process, making it the hub of any 

new media workflow. 

Neil LaVigne (www.behance.net/neillavigne; @

NeilLaVigne) is a New Media Design student at the 

Rochester Institute of Technology in New York. As 
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well as studying interactive, motion, 3D and 

experimental technology design, he also does 

freelance work. His passion for new media design 

and its applications is infectious. He says, “New 

media is an incredibly awesome and diverse field to 

be in. It encompasses so many different things like 

interaction, UX/UI, graphic design, motion graphics, 

3D, web design and development, and even playing 

around with experimental technology. Right now I 

focus mostly on UX/UI design because there is such 

a high demand for designers in that area, and in my 

free time I do 3D stuff. Not only do I design how 

applications look, but I also design the experience 

that the user journeys through, which is extremely 

powerful. Creating an experience is so different from 

just making visuals, but still uses design thinking.” 

For those who are just starting out in the design 

industry, it will be impossible to avoid new media. 

Many courses will introduce the basics of animation, 

Weather dashboard: “Development on a self-initiated project for a
dashboard for the world’s weather. I wanted to bring a bit of 
personality to the locations using well-known phrases to 
complement the location. Keeping the design clean and subtle, yet 
using gradient accent points for rollover/active states”

© STUDIOJQ



NEW MEDIA DESIGN    TECHNIQUES    

THE NEWMEDIA PHOTOSHOP PIPELINE

01 MODEL RENDERING
The scene was modeled and rendered

in Maxon Cinema 4D. Many of the textures I used

on the models I made in Photoshop, then imported

them to Cinema 4D. I began by modelling all my

assets in Cinema 4D. These models I could

duplicate to fill up the entire scene.

02 COMPOSITION SETUP
From making the individual pieces,

I began duplicating and arranging the models

into an interesting composition. I drew influence

from those huge train set village setups that had

a million different pieces and everything was

hand crafted.

03 LIGHTING AND TEXTURING
After being happy with the composition, I textured the models and lit the scene accordingly.

Once I had the final render, I took the still image into Photoshop, so I could add depth and subtle details.

motion graphics and user experiences alongside

traditional graphic design and illustration modules. 

In order to make a name for yourself in new media, 

however, you need more than an ability to master 

multiple software packages – the traditional traits of 

a good designer still count for a lot. LaVigne says, 

“New media centres around what is new, innovative 

and trendy. However, the most important thing is 

having core design skills, like knowing how to make 

a good composition, colour theory, gestalt principles 

and having good taste. These are the backbones to 

good design and will never be out-dated. New 

programs, technology and trends come out on a 

daily basis, but having an establishment with the 

fundamentals is king in design. Not only this but 

having a good work ethic, where you are constantly 

learning something new, and [are] passionate about 

what you do will give you a lot of satisfaction.”

This is a sentiment echoed by Tom Scott. Scott is a 

creative at seeper (www.seeper.com), a collective of

artists, creative coders and technologists who

specialise in creating interactive art, particularly

installations and projection mapping shows for

clients such as Nike, Sony, MTV, Google and Vimeo.

Scott states that, “Learning programs is always a

good starting point, but having the vision to create the

piece of work is more vital. Ideas are what count in

this industry.”

The key thing with new media is that you can

create something as flashy and sleek as you like,

but unless the functionality and accessibility has

been truly thought out, the project is destined to fail.

The user experience should always be at the

forefront of everything you design and create.

Photoshop forms an essential part of the new

media workflow, providing the tools and

technologies you need to create a wide range of

new media designs.

Practise is also important when it comes to

becoming a success in new media design;

self-initiated projects are popular on communities

like Behance and can open doors for talented

beginners. Brands are always looking for something

new, as it is more difficult for them to stand out from

the crowd and attract their target audiences.

Photoshop is an awesome 
tool for 3D programs, 

because I can make custom 
textures in Photoshop, save 
them as a PSD, then import 
them to Cinema 4D. [I can] map 
them on my models and if I want 
to change the texture, I just
update the Photoshop file
Neil LaVigne, www.behance.net/neillavigne

Caravan: Mobile Application : Caravan is a geolocation application used to create events 
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TECHNIQUES  NEW MEDIA DESIGN

INTERACTIVE DESIGN AND USER EXPERIENCE
One of the key areas that new media explores is 

that of user interaction – the ability for the 

audience to engage with design in a much more 

hands-on way than ever before. New media 

offers the chance to play with, change and 

influence a visual, especially when it comes to 

websites, user interfaces, apps and even 

large-scale installations.

Jonathan Quintin is the man behind STUDIOJQ 

(www.studiojq.co; @STUDIOJQ), an independent 

creative studio based in Bristol, specialising in 

branding, infographics, UI and editorial design for 

big-name clients like NBC Sports Network, AON, 

Manchester United and Bosch. Quintin shares the 

secrets behind a successful website or user 

interface, saying, “For us at STUDIOJQ, we truly do 

believe less is more. We are a studio that follows 

Swiss design closely, so we are huge lovers of 

negative space, heavily kerned typefaces and 

duotones. Colour is our biggest weapon in design, 

and when you pair it with a simplistic yet informative 

approach, you’re onto to a winner. We receive a lot 

of wonderful feedback from both clients and 

creatives expressing how much they love the way 

we use colour in such a simplistic yet effective and 

creative way.”

Building an engaging UI follows a tried-and-

tested workflow, which starts, surprisingly, with 

pen and paper – proving that for all the bells and 

whistles that new media can introduce, the 

simplest things are often the most effective. From 

the initial layout designs, a wireframe can be built, 

which gathers together all of the content for the 

UI. From here, research and development can 

begin on the overall brand direction and style, 

looking at the competition, surveying the industry 

and exploring other creative approaches. 

Concepts can be drawn up at this point, with 

constant adaption on all the individual elements 

to ensure that they look and feel just right for the 

target audience. 

Photoshop has a starring role to play in the 

Most people think Photoshop is only good for tweaking 
photos, yet it’s one of the most important tools to get the 

pixel-perfect look/layout the client and creative strive for
Jonathan Quintin, www.studiojq.co

DESIGNING INSTALLATIONS WITH
A PHOTOSHOP�BASED WORKFLOW

“Every project is different, but we usually start

by planning out milestones for the projects,

putting dates against them. We then start

planning our ideas through storyboards and

style frames to deliver to the client before we

start production.

We usually have a big input into the briefs

for our clients. They normally come to us with

the start of an idea or a particular building

they would like us to work with, which we

then turn into further concepts responding to

the brief.

TOM SCOTT OF SEEPER DESCRIBES THE PROCESS OF CREATING

The main tools we use are a mixture of 3D

packages and After Effects for the animation, and

Photoshop and Illustrator for planning,

storyboarding and design elements.

We use Photoshop mainly for style frames

to mock up what our work will look like in situ.

We also like to use it to create textures within

our 3D work.

The key element for a successful installation in

our eyes is making the audience feel immersed

within the work. We aim to create a sense of awe

and wonder.”

YTV: YTV is Canada’s biggest children’s television
channel. We designed and built them a publishing

platform for their game, video and blog content

Clear Noise: Clear Noise is an interactive installation 
about focus in a world of distraction, using a 

mind-reading headset that allows users to control 
visuals using their emotions
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THE IMPORTANCE 
OF PHOTOSHOP

While 3D programs like Maxon Cinema 4D and 

motion software like After Effects are 

recognised for their new media applications, 

every professional and studio that we spoke to 

for this feature described the importance of 

Photoshop when creating new media designs 

and assets. Photoshop has broken away from 

its original function of an image editor and now 

offers tools that enhance a new media 

workflow. Its ability to create textures for 3D 

files, design effective UIs and website assets, 

compile animations and build wireframes for 

mobile devices expand its potential. It’s an 

essential part of the pipeline and its integration 

with popular software programs is seamless.  

If you are a Creative Cloud subscriber, then you 

can easily switch between different programs, 

especially After Effects for motion work, and 

your Photoshop experience will help with the 

learning curve, especially if you have already 

experimented with Photoshop’s Timeline 

feature for basic animation. 

HOW THE ADOBE APP HAS RISEN 
TO MEET THE DEMANDS OF A NEW 
MEDIA WORKFLOW 
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JONATHAN QUINTIN SHOWS US HOW BRANDING HAS TO WORK ACROSS BOTH
TRADITIONAL MEDIA AND NEW MEDIA ALIKE TO CREATE A CONSISTENT CAMPAIGN

BRAND CONSISTENCY ACROSSMEDIA

01 LOOK AND FEEL
WAVERIDER is a fresh up-and-coming

wakeboarding brand, so striking the balance of a

powerful identity with an identity that works well

against its competitors. We wanted to create a

brand that was easy to follow and engage with,

using mono imagery and a neon colour palette.

02 BRAND PRESENCE
As branding is everywhere nowadays,

it would be a sin to have inconsistent branding

and imagery. Here are examples of how the

brand is to roll out in its requested habitat.

03 PRODUCT TREATMENT
It was extremely important to make

sure each of the WAVERIDER products were

advertised equally, as well as developing the new

fresh look of the brand. [We used] iconography to

distinguish and complement each of the product

names, making the online shop easy to navigate.

process, with Quintin proclaiming that they would be 

“lost without it”. With the evolution of CS and the raft 

of new media tools available in CC, Photoshop has 

moved on massively since its initial function as an 

image editor and its newer tools lend itself well to 

new media applications, such as UI design. Quintin 

explains, “We use Photoshop to create the overall 

grid, adapting imagery and slicing up imagery. Most 

people think Photoshop is only good for tweaking 

photos, yet it’s one of the most important tools to get 

the pixel-perfect look [and] layout the client and 

creative strive for.”

A passion for web design is essential in creating 

online experiences that attract audiences and keep 

their attention. Maciej Jasiobedzki, technical 

director, and Ryan Bannon, creative director, at 

Playground Inc (http://playgroundinc.com; @

playgroundinc) say, “We think about all the things

that we think are cool… And then try to make

something better than that.” Playground is a

Canadian digital creative agency, focusing on

design, consulting and technology. As a team,

Playground develops web solutions for a range of

high-profile clients, including Grammys.ca and YTV.

They go on to say, “We strive to create meaning

and value for our customers and their users, and

seek to imbue our products with a sense of

wonder. We are a diverse team of creatives from

many backgrounds with a shared desire to help

make the web a better place by crafting the best

digital experiences.”

Up-and-coming designers who hope to break into

web design need to keep up to date with the ever

changing internet and not be afraid to break new

ground in order to stand out. Jasiobedzki and Bannon

advise that you, “Work really hard and make good

things; the world has enough garbage. The web

moves fast. Take a risk and don’t be afraid to take a

stand for what you believe in.”

The Smiller, Alton Towers: Projection-
mapped optical illusions. An immersive 
installation for a queue line at Alton Towers

Kraftwork: A projection-mapping 
show on the original Volkswagen 
factory in Wolfsburg, Germany

Legacy Cap Co.: Development of a new brand we are 
proud to be part of. Keeping the identity simple yet 
powerful and distinguished
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SJQHUB: Concept development for a dashboard showing skill 
sets from our studio, using a vibrant and powerful colour palette 
with surreal imagery and clean statistics and layouts
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EFFECTIVE ANIMATION WITH PHOTOSHOP’S TOOLS
For every sleek and glossy website or app, there 

is an equally attractive one that relies on 

engaging characters and quirky graphics to 

create a fun and colourful experience. Animation 

is well-used on the internet, but quality is 

paramount, especially in a commercial context.

Animade (www.animade.tv; @animadetv) is a

small award-winning animation and interactive 

design studio based in London. Its work, for 

clients such as Nickelodeon, Google and Virgin 

America, spans a spectrum from interaction to 

animation and everything in-between, including 

installations and mobile gaming. 

When questioned on what makes an animation

stand out, creative director Edward Barrett says, 

“We’ve found it’s best to simplify design and use 

clean forms to maintain a high standard of 

motion graphics and character animation. We 

believe there’s something inherently engaging 

about well-timed and fluid animation. An 

audience may not understand animation or have 

any particular design preference, but if something

moves convincingly with character and charm, 

the viewer embraces it – consciously or not.”

For 2D animation, Photoshop is an essential 

part of the process, as Barrett explains, “We like 

to use Photoshop a lot as it’s our preference for 

drawn animation and storyboarding. The timeline 

is a particularly useful feature especially when it’s 

combined with the custom shortcuts, because it 

becomes a very quick and easy tool for 

frame-by-frame animation.”

The team at Playground Inc used animation to 

help build its new online identity. The unique 

graphics are vector-based animations and offer

a distinctive look that is simple but effective in

portraying its services. You can see the

animations in action on the studio’s website at

www.playgroundinc.com. The simplicity of the

animation in no way reflects the complexity of

the process that went on behind the scenes. It

took a lot of trial and error, and led to using

Photoshop in ways that the team had not

previously considered.

We use Photoshop a lot as it’s our preference for drawn
animation and storyboarding. The timeline is a particularly 

useful feature and when combined with the custom shortcuts it 
becomes a very quick and easy tool for frame-by-frame animation
Edward Barrett, Animade, www.animade.tv

A BRIEF OVERVIEW OF THE COMPLEX PROCESS OF BUILDING VECTOR ANIMATIONS ON THE PLAYGROUND INC WEBSITE

ENGAGING VECTOR ANIMATIONS WITH PHOTOSHOP

01 INITIAL SKETCHES
We had an idea of how we wanted things

to look and feel, and were excited about using 

vectors. We needed to start prototyping and get 

something into the browser. Chris Makerewich put

together 12 frames of a simple animation for us to

test with. We quickly traced over the hand-drawn 

sketches and created some SVGs.

02 VECTOR GRAPHICS AND
PHOTOSHOP LAYERS

We [found] a promising technological solution (see

the full process at http://playgroundinc.com/

blog/the-playground-vector-animation-

process/) Chris had hand-drawn the major poses,

spread those out on a timeline to establish a sense

of rhythm and drawn the remaining frames in

between, all in Photoshop as a series of raster

layers. Ryan Bannon traced the 72 frames in

Illustrator to produce something vector-based.

03 FROM PSD TO SVG
It was very obvious that tracing over every

layer in every frame of every PSD was not going to

be a good long-term solution. [After finding a

solution] we had one PSD for each frame. We

needed to… Take all those files and convert them

into SVGs… We then enlisted Illustrator and

created a handy batch action.

Multi Device: We were building a responsive website. We wanted to create a good experience for all of our 
users: mobile, tablet, desktop, Hi-DPI. We wanted to create a jaw-dropping experience users had never seen 

and we didn’t want to have to compromise for technical reasons

Animation for the web presents its own series 

of challenges. The Playground Inc team explains, 

“Animating for the web might on the surface 

seem like any old animation, but the reality is 

rather different. In traditional animation you 

know the resolution and aspect ratio of your field. 

In our case we were embedding animations into 

pages, the layout of which was so far 

undetermined and, in fact, would actually change 

depending on devices, screens, browsers, etc.” 
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THE ANIMATION
WORKFLOW

“Typically, we receive a brief and script that we

interpret into a storyboard. We tailor the design

based on the volume of character content and

action in the storyboard. This enables us to

keep the standard of animation as high as

possible; for example, if a character does a lot

of walking we won’t design them with stumpy

legs, or if we have to display a certain amount

of emotion we’ll focus our efforts on the face

and eyes.

[Next] we can begin the animation process.

Sometimes this starts with an animatic; using

the designed characters we time out scenes

and actions using still poses. If we’re using

puppet-based software, such as After Effects,

these poses can sometimes become the

actual keyframes of the animation.

As the animation stage finishes up we hand

the image over to a sound partner to work

their magic. If all goes well, the animation is

signed off and we deliver the final files.”

EDWARD BARRETT, CREATIVE DIRECTOR
AT ANIMADE, TALKS US THROUGH THE
STUDIO’S TYPICAL WORKFLOW PROCESS

The most complex part of the process was in

translating the Photoshop PSD files into SVG, for

which the team had to delve into the world of

Photoshop Actions and Scripts to save out each

individual graphics frame as a PSD that could be

taken into Illustrator to convert to SVG files. Of

course, there was a lot more to it than this.

With programs like Photoshop offering

accessible animation tools, it means that any

graphic designer and digital artist now has the

chance to bring their two-dimensional designs

to life, which can have ramifications for the

quality and volume of animations on the

internet. Edward Barrett thinks that, “It could

be said that as the internet gets fuller and our

attention spans get shorter, animation will

become a more viable method of short, sharp

communication; or as online budgets

decrease, so will the standard of the

animation in adverts and short films.”

Still from Corridor: An internal project
designed and animated by Lana
Simanenkova, Corridor visits the dark
secrets that dwell in private apartments

Still from Message: A friendly intro film
for web app Message, using Cinema 4D

Still from The Wall: The Wall is a mesmerising loop
of a bricklayer at work, designed and animated by
Milo Targett as an internal project

Complex graphics: The lady in ‘Make the web a better place’ has pretty great hair. This took Chris several 
days to complete as her hair needed to sway and bunch up without bubbling or looking weird. It’s no 

coincidence that all the other characters are either bald or have sharp angular hair
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BLENDING MOTION 
WITH 3D USING 
PHOTOSHOP
Motion graphics are increasingly used in 

advertising campaigns, for branding projects and 

on websites, and at the same time they are getting 

increasingly sophisticated. More and more brands 

are using motion to showcase their products, as a 

good visual is likely to get picked up by social 

media and start trending, raising visibility. 

It’s easy to see why motion graphics have such 

an appeal, especially when it comes to the 

commercial world. Andreas Wannerstedt (www.

andreaswannerstedt.se; @wannerstedt) is a 

designer and motion graphics artist currently living 

and working in Stockholm, Sweden, and has 

worked for such notable clients as IKEA, Absolut 

Vodka, Coca-Cola and Adidas. He says that, “with 

motion it’s possible to easily simplify a message… 

Presenting a large piece of information in an 

attractive way. Motion graphics are better at 

attracting the attention of the viewers, rather than 

static pictures or graphics”. 

In order to catch the attention of the ever-

harder-to-please public, a myriad of software 

programs have to come together in one workflow 

to produce high-end, eye-catching visuals. For 

Wannerstedt, the process starts on paper, 

sketching various ideas for environments and 

camera angles. Photoshop comes next in order to 

create a quick storyboard with placeholder images, 

which can be taken into After Effects with the 

soundtrack to get an idea of what scenes are 

needed or can be cut. The environments can then 

be modelled in Cinema 4D, at first very basically, 

before starting the real work of building up and 

rendering the 3D environments – the most 

time-consuming part of the project, and yet the 

most important. Post-production happens in After 

Effects (colour corrections, depth of field, motion 

blur and lens effects), as well as adding in any 

typography and 2D animations. 

I use Photoshop on and off throughout the entire creation 
process, but mainly when working with the textures and the 

different maps for the 3D objects… Photoshop makes it possible to 
easily create wear and imperfections in the textures, which are very 
important elements when trying to create a photorealistic look
Andreas Wannerstedt, www.andreaswannerstedt.se

PHOTOSHOP 
COURSES FOR NEW 
MEDIA DESIGNERS 

ANIMATING CONCEPT 
STORYBOARDS USING 
PHOTOSHOP AND 
AFTER EFFECTS

RESPONSIVE MEDIA

VIDEO EDITING BASICS

If you want to turn your graphics into 

animations, then this course will help you 

make the most of Adobe CC’s After Effects 

package in conjunction with your Photoshop 

designs. You will learn to create concept 

storyboards that are simply animated. 

If you want to create layouts and designs that 

will work across multiple devices, then this 

beginner-level course will help you with the 

basics of creating fluid grid layouts and custom 

design experiences. Learn how to prepare 

images, fonts and videos for any output device. 

Adobe offers a range of free tutorials on using 

all the features in Photoshop that you might 

not have delved into yet, and this can be a good 

place to start if you want to understand what is 

possible before trying other software.

IF YOU’RE KEEN TO BUILD NEW MEDIA 
SKILLS WITHIN PHOTOSHOP, THEN 
HERE ARE SOME OF THE BEST ONLINE 
COURSES AVAILABLE 

www.digitaltutors.com 
Membership from $29/month

www.lynda.com 
Membership from $25/month

http://helpx.adobe.com/photoshop.html 
Free

3D work: “I have set out on a quest to do ‘A Project a Day’ that
is new media related in order to enhanced my skills and learn
something new everyday. This was one of my daily projects”

Nova: A still from Nova, a self-initiated 3D short film
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Photoshop has an important role to play in this

process, as Wannerstedt explains: “I use

Photoshop on and off throughout the entire

creation process, but mainly when working with

the textures and the different maps for the 3D

objects. These textures are created by merging

multiple photos and I often use the Brush tool to

highlight special surfaces or edges. Photoshop

makes it possible to easily create wear and

imperfections in the textures, which are very

important elements when trying to create a

photorealistic look. I often use a lot of different

custom brushes for these kind of textures.”

Neil LaVigne uses Photoshop in a similar

manner for his 3D work and states that,

“Photoshop is an awesome tool for 3D programs,

because I can make custom textures in Photoshop,

save them as a PSD, then import them to Cinema

4D. [I can] map them on my models and if I want to

change the texture, I just update the Photoshop

file. 3D programs are awesome at creating visual

effects, but they can be almost too precise in

rendering and lack those subtle details we see in

real life.”

Getting the technical aspects right is obviously

important, but there is more to creating an

engaging motion graphic.

Wannerstedt says, “I think that good motion

design contains a strong visual interest and sense

of movement, and presents the message or

concept in an appropriate way. We have been

spoiled with fantastic motion design [recently].

Now it’s all about the details: the concept, the

visuals and the animation – it all needs to be

top-notch to capture the attention of an audience.

Sound is obviously also very important and it can

make a major difference in any motion piece.”

ANDREAS WANNERSTEDT BREAKS DOWN THIS PERSONAL
PROJECT, A 3D SHORT FILM CALLED NOVA

3D INMOTION

01 3D GEOMETRY
This film is about a future where

scientists are able to create artificial,

self-sufficient, miniature suns. This is the

geometry in Cinema 4D. This scene uses a

very simple light setup with only a sun that

animates around the 3D stage.

02 RAW 3D RENDER
This is the raw render straight from

Maxon Cinema 4D. The image can often appear

quite flat at this point, but now it’s time for some

adjustments in After Effects.

03 POST ADJUSTMENT AND EFFECTS
Here I’ve applied some different post effects such as depth of field, glow, distance fog,

chromatic aberration, vignette and some overall colour correction. Since I work with a 32-bit linear

workflow, the colour correction becomes very flexible.

SoulBot: Designed, directed and animated by Andreas
Wannerstedt, this is a still from a 3D motion design

Genesis: An example of a still from a 3D film created, written 
and animated by Andreas Wannerstedt

Consumed: A self-initiated personal project. It’s a 3D short film 
about a not-so-distant future, where extreme overpopulation 
has become a global crisis
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REVIEWS  MOLESKINE SMART NOTEBOOK

Sketch on the move: Sketch in the Smart Notebook and use a CC app to send your artwork straight to Photoshop 



MOLESKINE SMART 
NOTEBOOK

083

hether you create digital paintings,

graphic design or compose

photomanipulations, it’s likely that

you’ll start your work with a basic

compositional sketch to give you an idea of how

you want your image to look. If you create

paintings, illustrations or comic art, you may

well find yourself spending a lot of time

sketching and refining line art. And for many of

us, despite the wealth and quality of digital

sketching tools within Photoshop and other

programs, the first port of call when sketching or

developing line art is still a good old-fashioned

sketchbook. But transferring your initial drawing

to Photoshop can be something of a pain. You

need to scan or photograph it, then spend time

adjusting tones and messing around with

Channels and selections to clean up your lines

and make them usable in a digital piece. Nine

times out of ten, you’ll probably end up re-inking

THIS NEW APP�AND�SKETCHBOOK COMBO BRIDGES THE GAP 
BETWEEN PHYSICAL AND DIGITAL ART, BUT WILL IT CATCH ON 
AMONG PHOTOSHOP USERS? WE FIND OUT WHETHER IT WILL 
REVOLUTIONISE THE WAY YOU START A PIECE OF ARTWORK 

moleskine.com
them digitally in order to make sure that they 

show up enough for you to work with. It’s a long, 

drawn-out process that slows down the first 

phase of your workflow. What if there was 

something that could make this part of the 

process easier, that would allow you to combine 

the best aspects of traditional sketching with the 

power of Photoshop? Well, now there is: the 

Moleskine Smart Notebook, created by the iconic 

notebook manufacturer and Adobe. 

Recommended pen: You can draw with anything, but will get the best results from a Sharpie or Moleskine rollerball in black
Classic Moleskine: The Smart Notebook features Moleskine’s iconic design with    an attractive wavy texture
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REVIEWS  MOLESKINE SMART NOTEBOOK

This clever little sketchbook/app combo allows

you to sketch in the time-honoured fashion, and

then easily transfer your drawing to Photoshop.

There’s no worrying about cleaning up line art and

scanning artefacts, no complex procedures with

Channels and inverted selections, just a fairly swift,

intuitive process.

There have been forays into this area before. A

few years ago, Wacom’s Inkling – a hybrid ballpoint/

digital pen – tried to achieve the same thing from

the opposite angle, focusing on the pen itself as the

Capture your sketch: The accompanying CC app for the SmartNotebook captures your sketch via your iPhone camera. Theseorange margins allow you to centre the shot to ensure that youcapture everything you need to upload to your CC Library

WACOM INKLING  
Wacom’s Inkling, a combination of ballpoint pen 

and digital receiver, launched in 2011 to great 

fanfare, promising to revolutionise the way that 

you began your digital art workflow. While the pen

itself was as well-engineered as you would expect

from Wacom, the software that supported the 

digital side of the pen was panned by many 

consumers, who criticised it for producing uneven 

results and for compatibility issues, especially with

the advent of CC. Priced at around £100 when new,

the Inkling can still command a price of anything 

between £85 and £160 from Wacom enthusiasts, 

digital repository of your sketches. This wasn’t 

without its problems – the big, bulldog-clip style 

digital receiver that was necessary to beam your 

sketches into the digital space was large and 

unwieldy, taking up far too much of your drawing 

space and reducing the Inkling’s portability and 

usability when you were out and about. The pen 

itself suffered from problems with pressure-

sensitivity and accurate reproduction, and some 

users complained that their sketches came out 

misaligned and unusable. 

Portable artwork: The Smart Notebook is A5 in size so you can use it practically anywhere without the need for a desk

Adobe and Moleskine have approached the 

problem from the other side, concentrating instead 

on the sketchbook itself and leveraging the power of 

CC apps and Libraries. This means that their solution 

is not only more portable – the Smart Notebook is 

exactly the same size and weight as every other A5 

Moleskine, something a lot of us are used to carrying 

around – but also offers more accurate reproduction 

of your artwork thanks to an app similar to Adobe 

Brush and Adobe Shape CC, which you use to 

capture your lines. 

perhaps partly due to the fact that it was 

discontinued in 2014. Despite the software-side 

problems experienced by some users – and the 

large, heavy receiver you needed to clip to your 

sketchpad in order to transfer your sketches 

digitally – many artists were excited about the 

Inkling and looked forward to seeing a 

second-generation product that improved on its 

capabilities and portability. We’d love to see a 

combination that mixed the pen capabilities of 

the Inkling with the ease of use and lightness of 

the Moleskine Smart Notebook. 

Stay central: Try and keep your sketches in the middle of the paper for best results
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At first glance this seems counter-intuitive – surely 

capturing an image with a phone camera is less 

effective than scanning your artwork at high-

resolution and spending the time processing it ready

for use? In actual fact, it’s remarkably effective. 

Adobe has invested a lot in making its portfolio of CC

apps powerful, quick and intuitive to use and the 

Moleskine Smart Notebook app is no exception. 

Just like Adobe Brush, you simply use your phone 

(iPhone only right now) to capture your sketch. 

This is aided by guide marks on the edges of the 

Smart Notebook’s pages. Despite seeming like a 

lower-tech solution, it’s actually much more 

effective than Wacom’s Inkling. You can check and 

edit your sketch within the app in JPG format, and 

when you’re done it’ll be converted to SVG and sent

straight to your Creative Cloud Library as an Asset.

Features: 8/10
Ease of use: 9/10
Quality of results: 7/10
Value for money: 7/10

VERDICT

FINAL SCORE: 8/10

The SVG format allows you to scale your sketch up 

or down without losing resolution, so you can 

work up your artwork in whatever size or 

resolution you like. 

While some artists will no doubt be unhappy that 

the Moleskine Smart Notebook doesn’t currently 

have an equivalent Android app, and that it’s only 

compatible with the CC versions of Adobe’s software, 

it’s worth noting that this product couldn’t exist 

without the capabilities of the Creative Cloud. It’s a 

great innovation along the road to better real media/

digital integration, and it’s easy, intuitive and fun to 

use. If you’re a compulsive sketcher, an iPhone 

owner and a CC user already, this will streamline the 

beginning of your image workflow. Whether it’s 

exciting enough to convert more artists to a CC 

subscription however, remains to be seen. 

WHAT THE 
MANUFACTURER SAYS 
Serge Jespers reveals how Adobe and 
Moleskine collaborated on this project

We spoke to Serge 

Jespers, senior Creative 

Cloud evangelist with 

Adobe, to find out more 

about the inspiration 

behind the Moleskine 

Smart Notebook and how you can get the  

most from it.  
 
WHERE DID THE IDEA FOR THE SMART NOTEBOOK    
COME FROM?
I reached out to Moleskine when we started 

looking for launch partners for the Creative SDK 

[the software development kit that allows 

third-party developers to create CC-compatible 

apps and programs]. Moleskine has done Smart 

Notebooks before [for EverNote] and came back 

to us with this idea.

ARE THERE ANY PARTICULAR PENS/PENCILS/MARKERS 
YOU RECOMMEND ARTISTS USE TO GET THE BEST    
IMAGE RESULTS WHEN UPLOADING TO THEIR      
CREATIVE CLOUD LIBRARY? 
It would work with anything but something like 

a Sharpie would give the best image results.

HOW DO YOU THINK IT WILL CHANGE THE WAY THAT 
DIGITAL ARTISTS BEGIN THEIR PROCESS? 
A lot of ideas still start on paper. There has 

always been a disconnect between the 

paper sketch and a designer’s digital 

workflow. This helps bridge that gap. 

Instead of having to manually scan a 

notebook and then manually trace it, this 

workflow is a great shortcut. With just a 

couple of clicks you get a vector file that you 

can edit in Adobe’s desktop apps. 

Making marks: These little squares help the Smart Notebook app to focus on your drawing when you capture it on your phone

Banish line art woes: Not only can you capture artwork on the move, it’s also easier than refining scanned line art



WITH A BOLD, CLEAN STYLE, ILLUSTRATOR AND DESIGNER
CHRISTINE ROY DISCUSSES HER SUCCESS

THE GROWTH OF 
AN ARTIST

READER INTERVIEW   THE GROWTH OF AN ARTIST

OUR READER
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CHRISTINE ROY
www.agentillustrateur.com 

@Ag_Illustrateur

W ith her painter-like, bold and distinctive 

style, Christine Roy has been making 

her mark both in her home town of 

Montreal and internationally in the 

illustration industry. Her creative style has also been 

winning praise, not only on the Advanced 

Photoshop website, but from big-name clients. 

Check out her Gallery on our website at (www.

advancedphotoshop.co.uk/user/croydesign).

WHEN DID YOU START USING PHOTOSHOP?

I started out very early playing on my dad’s computer. 

I think I was ten years old and my idea of fun was to 

reproduce Windows’ icons with CorelDRAW and Corel 

PHOTO-PAINT. By the end of the Nineties, I 

discovered Photoshop and was astonished by the 

new possibilities of the layers and it became the 

perfect accomplice for my illustration work. Since 

then, Photoshop has become the most instinctive 

software for me to use. 

HOW DID YOU START WORKING 

PROFESSIONALLY AS AN ARTIST?

During my major in film production, I was involved 

in Concordia University’s magazine called L’Organe 

– this was the first step into my professional path 

into graphic design and illustration. Back then we 

had the freedom to create crazy cover concepts 

and creative editorials. I was an illustrator and later 

became the art director of the magazine. As I’m 

self-taught, this is where I learnt most of the things 

I know about design. From there, I made my very 

first portfolio and started as a freelancer for ad 

agencies before launching my graphic design and 

Free Speech:
Christine says, “You could say I keep it 
pretty simple by using the Path tool, 
the basic brushes, the layer masks 
and the blending modes a lot... I also 
play with the Dodge and Burn to push 
forward the level of details”
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Ballerina: Christine admits she has used the 
same combination of software features since 

the mid-Nineties even if Photoshop offers 
plenty of new awesome tools

Fêtes: This is a personal illustration Christine 
made for the birthday of a friend. “Birthdays are a 
nice pretext for me to experiment with illustration 
and give a personal gift to loved ones” 

Function that leads to an emotional response, 
that’s what makes illustration and design an 

appealing means of expression

Reach: Christine tries to get out of her comfort 
zone with difficult shapes, odd colour 

combinations or pure abstraction
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You could say that, before I was only 
looking at one tree at a time, now I 

see the whole forest – the big picture

A Loop in Time:  Christine states, “I like 
the fact [A Loop in Time] is a little 
abstract, so every time you look at it, 
you can think of a different story that 
gives the visual a different meaning. The 
colours are also unusual and I’m still 
drawn to the big bright yellow colour, it’s 
a bold, visual statement”



other designers’ or illustrators’ work, I prefer to get 

inspired by other disciplines like abstract paintings. 

After that, I like getting rid of the administration stuff like 

accounting, follow-ups with clients and briefing my 

designer on the deliverables. Once my head is clear, I 

can work long stretches of hours in front of the 

computer on two or three projects at a time. Towards 

the very end of the day I often end up focusing on a 

personal project and let my ideas run wild – it’s my 

most creative time.

HOW HAS YOUR WORKFLOW CHANGED SINCE 

YOU STARTED OUT?

I was quite messy before, I didn’t have any sort of 

process or workflow, I was really just following my 

ideas and creating stuff on the spot. Now I’m more 

patient, I let the ideas live a little bit by doing early 

sketches, leaving them for a few days before actually 

turning them into illustrations. That way I find the 

outcome more polished, more nuanced. I also started 

to be more organised and strategic in order to continue 

to work for more international clients. You could say 

that, before I was only looking at one tree at a time, now 

I see the whole forest – the big picture. 

THE GROWTH OF AN ARTIST  READER INTERVIEW
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Both Christine’s work and her approach to it 

combine imagination and discipline in a fruitful 

way. Her first piece of advice to young creatives 

is simple: “Allow yourself to be bored. From 

boredom you’ll be surprised how creative you 

can be. When you have a brief in front of you, 

have a strong subject and keep the execution 

simple. Use your style to support the idea, don’t 

use fancy visual gimmicks if there’s no rationale 

behind it – but don’t go for the safe option either. 

Be confident in your own ideas. If you hesitate 

between a few ideas, always pick the wild one.”

DESIGN TIPS

illustration studio, Agent Illustrateur, in 2008 and

eventually got into teaching graphic design and

visual language in 2012.

WHAT INSPIRES YOU?

Music and fine arts does wonders for my imagination.

I’m very cerebral, almost too pragmatic sometimes

and to create inspiring visuals that convey emotions, I

have to immerse myself with music, either classical or

electronic. I also have go-to composers like Erik Satie

or Zbigniew Preisner. Music simply allows me to create

ideas from scratch, away from another’s work or style. 

Imitating or creating visuals that are similar to

someone’s work is my greatest fear. As for fine arts, I 

really love the work of Marc Seguin, a French-Canadian 

artist, it’s dark and it makes you think about the absurd 

side of our society. I’m also a huge fan of René Magritte, 

a Belgian surrealist artist that made timeless,

unexpected paintings.

WHAT DO YOU FIND CHALLENGING?

The fact that there is a million good ways to visually 

communicate the same message is a real challenge. 

You always have to make difficult choices and to be 

confident in your vision. Creating something new and 

original, that makes sense visually and conveys a 

strong message with a simple concept is my ultimate 

goal. Function that leads to an emotional response, 

that’s what makes illustration and design an appealing 

mean of expression.

WHAT’S A TYPICAL WORKING DAY FOR YOU?

I’m really a creature of habits, so every morning I go the 

studio and start the day with a lot of visual research 

while taking my coffee. I do not look necessarily for 

Toblerone:
When working with big brands, Christine has a straightforward approach, noting that “Branding is not 
something that must be taken superficially or just at the visual level, I approach branding as an essential 
business lever for clients and help them achieve their long-term goals”

Winter Fox: A Christmas image Christine created 
to thank clients for their business

Emrical: This album cover was commissioned by 
hip-hop artist Emrical, who gave Christine total 
creative freedom. She was inspired by “the 
spirituality of his songs”



CREATE YOUR 
OWN MARBLE 
TEXTURES

Marbling paper has its roots in Japanese 

culture and the Japanese ink for marbling 

paper can be purchased online. But if this route 

is not for you because of either accessibility or 

price, household tools can be used to create 

very similar effects, which are simply perfect 

for digital applications. The tools mentioned in 

this tutorial include nail polish, food dye, and 

acrylic paint. Each of these mediums creates a 

unique marbled appearance.

ATE THE COLOURFUL SWIRLS OF 
E WITHOUT EVER CRACKING A STONE

hen thinking of marble, classical 

sculpture may be the only thing that 

comes to mind. However, the 

effect of marbling can be produced 

in a variety of ways with a variety of colours, 

instantly adding flare to a project. Creating 

unique marble textures is easy to do with only 

everyday household ingredients. Without much 

effort you can create many different marbled 

papers in just minutes and for very little cost. 

Nail polish suspended on water

creates random, vibrant marble

patterns. Use thin nail polish for

more transparent effects and

thicker for brighter colours

Liquid starch and alum powder mixed are 

a good base for thicker colour. Acrylic paint 

on top of these will create a washy look

Shaving cream and food dye can be used to 

make detailed patterns with lots of control

Regardless of which method you use, 

make sure you have an easy-to-clean 

surface to work on. Also make sure 

you have a space for the papers to dry
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CREATE YOUR OWN MARBLE TEXTURES  ON FILESILO

SHAVING CREAM MARBLE TEXTURES
USING EVERYDAY MATERIALS TO CREATE COLOURFUL MARBLE EFFECTS

NAIL POLISH MARBLING
USING NAIL POLISH TO CREATE A MARBLED EFFECT

03 PLACE THE PAPER
Once you have a design you’re happy with, 

lay a piece of regular paper over the shaving cream 

and press down evenly. Then peel the paper up and 

scrape off the excess shaving cream.

03 TRANSFER ONTO PAPER
Lay a piece of paper on the surface of the 

nail polish. Make sure that there are no air bubbles. 

Then pull it off the water – all the nail polish on the 

surface should come with it.

02 DROP AND SWIRL
Pick your colours of food dye and drop a 

few drops around the shaving cream. Then, using a 

straw or toothpick, swirl the colours together to 

create your marbled effect.

02 SWIRL AND MAKE A PATTERN
Quickly, pour enough nail polish to cover a 

piece of paper. Then use a toothpick to swirl the 

colours together. Do this quickly before it dries. 

01 SPREAD THE FOAM
Using a foaming shaving cream, spray a 

wax paper-covered pan. Spray in an area about the 

size of a piece of paper in an even layer.

01 DROP THE COLOURS
Pick out as many colours of nail polish as 

you want. Unscrew all the caps and line them up. In a 

tray filled a few inches with water, pour the nail 

polish in a swirling or drop-like pattern.
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Start by rendering a cloud layer. Then duplicate it and put a gradient map 

adjustment layer over it. Then blur the cloud layer until you get a marbled finish.

DIGITAL MARBLE EFFECT
MAKING A COMPLETELY DIGITAL MARBLE LOOK

Tweak the gradient as much as you 

want, colour and roughness are fun to 

explore. Increasing the roughness will 

give you more contrast and colours. 

Lower roughness will give you less 

contrast and fewer colour variations

You can always change the original 

cloud rendering if you don’t like   

the look of the first one

Increase the blur on the cloud layer to 

create fewer, more bold colours and 

increased smoothness and lower the 

blur for a bumpier, sharper image

On the blurred cloud layer, use the smudge brush 

to create more texture and marbleise it further. 

Drag out certain areas to create swirls and shapes 

similar to the other marble effects in this tutorial
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CREATE YOUR OWN MARBLE TEXTURES  ON FILESILO

If you are creating marble textures, don’t you just have to make a statue? In

Photoshop it’s really easy, just download a 3D model and apply the marble

textures. There’s plenty of available 3D models through 3D>Get More Content.

Then 3D>New 3D Layer from File to deposit the model into your scene.

To properly use the marble textures on a 3D model, the texture needs to be

seamless. Open up one of the textures and go to Filter>Other>Offset to make

the texture seams visible. Remove these with the Healing brush or the 

Content Aware Fill tool. Then apply this new texture to the Diffuse property of 

each material in the 3D panel. Even after rendering, the model will require 

some touch-ups by hand.

For a more detailed walk through of this process, please check out the 

video tutorial that accompanies this project on FileSilo. 

DIGITAL MARBLE SCULPTURE
CRAFT A SCULPTURE USING THE MARBLE TEXTURES



CREATE A COLOURFUL PAINT MARBLING
USING ACRYLIC PAINT AND HOUSEHOLD INGREDIENTS TO MAKE A MARBLE EFFECT

02 PICK YOUR PAINTS
Pick your acrylic paint colours and put 

them in bowls with some water. Mix them together 

to thin the paint so it pours easily and doesn’t sink 

when poured in the tray.

03 FINISH UP AND DRY OFF
Pour the colours around the tray. Swirl them with a toothpick, then lay a piece of 

paper over it to transfer the design. These will take a while to dry because of the starch, so you 

may need to dry them with a hairdryer.

01 PREPARE THE LIQUID
Combine in a tray, liquid starch and a half 

teaspoon of alum powder. Mix those together and 

set aside till it comes to room temperature.

We’ve included thirteen different textures for you 

to use. Just download them from FileSilo and 

incorporate them as textures in your own work.

MARBLE TEXTURES
13 COLOURFUL MARBLE TEXTURES

ON FILESILO  CREATE YOUR OWN MARBLE TEXTURES
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LANDSCAPE TIPS SHOOTING ADVICE CAMERA REVIEWSPORTRAIT GUIDES

Available
from all good

newsagents and
supermarkets

WILDLIFE PHOTOS

Learn to inspire
www.dphotographer.com

BUY YOUR ISSUE TODAY
Print edition available at www.imagineshop.co.uk

Digital edition available at www.greatdigitalmags.com

facebook.com/DigitalPhotographerUK twitter.com/DPhotographer
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> Capture motion > Master low-light portraits > Gig photography
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RESOURCES  FILESILO

YOUR FREE RESOURCES
LOG IN TO WWW.FILESILO.CO.UK/ADVANCEDPHOTOSHOP AND 
DOWNLOAD YOUR FANTASTIC PHOTOSHOP RESOURCES NOW

YOUR BONUS 
RESOURCES

ON FILESILO THIS ISSUE, FREE AND 
EXCLUSIVE FOR ADVANCED PHOTOSHOP 
READERS, YOU’LL FIND RESOURCES 
WORTH £106, INCLUDING…

■  200 Photoshop Actions worth £75

■  Recharge Regular font worth £16.99

■ 21 Mercurycode textures worth $10

■  Video tutorial on how to apply marble 

textures to 3D renders in Photoshop

■  Grungy wall textures worth $5

■ Fonts, patterns, web buttons and more

■ All tutorial files for this issue

EXPERT TUTORIALS

21 PRO TEXTURES

TOTAL
COMBINED
VALUE:

www.filesilo.co.uk/advancedphotoshop

£106

EVERYTHING YOU 

NEED TO FOLLOW 

ALONG WITH THE
MAGAZINE AND
CREATE GREAT

PHOTOSHOP ART

CREATIVE 
RESOURCES
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FILESILO – THE HOME OF PRO RESOURCES

The most popular downloads are shown in 
the carousel here, so check out what your 
fellow readers are enjoying! 

Green open padlocks show the issues you 
have accessed. Red closed padlocks show 
the ones you need to buy or unlock.  

Find out more about our online stores, and 
useful FAQs like our cookie and privacy 
policies and contact details. 

If you’re looking for a particular type of 
content like brushes or fonts, use the filters 
here to refine your search. 

Can’t find the resource you’re looking for in 
these filters? Click on More Types to specify 
exactly what kind of resource you want.

Top Downloads are listed here, so you can 
get an instant look at the most popular 
downloaded content. 

Check out the Highest Rated list to see the 
resources that other readers have voted for 
as the best! 

Discover our amazing sister magazines and 
the wealth of content and information that 
they provide. 

The first time you use FileSilo you’ll need to 
register. After that, you can use the email 
address and password you provided to log in. 

This is the new FileSilo site that replaces 
your disc. You’ll find it by visiting the link on 
the following page. 
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A rapidly growing library 
Updated continually with cool resources
Lets you keep your downloads organised
Browse and access your content from anywhere
No more torn disc pages to ruin your magazines

No more broken discs
Print subscribers get all the content
Digital magazine owners get all the content too!
Each issue’s content is free with your magazine
Secure online access to your free resources

DISCOVER YOUR FREE ONLINE ASSETS



HOW TO US
EVERYTHING YOU NEED TO KNOW ABOUT 
ACCESSING YOUR NEW DIGITAL REPOSITORY
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Having trouble with any of the techniques in this issue’s tutorials? Don’t know how to make the 
best use of your free resources? Want to have your work critiqued by those in the know? Then why 
not visit the Advanced Photoshop Facebook page for all your questions, concerns and qualms. 
There is a friendly community of fellow Photoshop users to help you out, as well as regular posts 
and updates from the magazine team. Like us today and start chatting! 

facebook.com/AdvancedPhotoshop

NEED HELP WITH
THE TUTORIALS?

Issue 133 of   is on sale 19 Mar 2015 from GreatDigitalMags.com                      

RESOURCES  FILESILO

ToaccessFileSilo,pleasevisitwww.filesilo.co.uk/advancedphotoshop

01 Follow the 
instructions 

on-screen to create an 
account with our secure 
FileSilo system, then log in 
and unlock the issue by 
answering a simple 

question about 
the magazine. 
You can access 
plenty of 
content for free 
with the issue. 

02 If you’re a print 
subscriber, you 

can easily unlock all the 
content by entering your 
unique Web ID. Your 
Web ID is the eight-digit 
alphanumeric code 
printed above your 
address details on the 
mailing labels of your 
subscription copies. It 
can also be found on 
your renewal letters..

03 You can access 
FileSilo on any 

desktop, tablet or 
smartphone device 
using any popular 
browser (such as Safari, 
Firefox or Google 
Chrome). However, we 
recommend that you use 
a desktop to download 
content, as you may not 
be able to download files 
to your phone or tablet.  

04 If you have any 
problems with 

accessing content on 
FileSilo, or with the 
registration process, take a 
look at the FAQs online or 
email filesilohelp@
imagine-publishing.co.uk.






